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User Information

Online Registration
Be sure to register your product at our online support center:

Telephone Support
For telephone support, call this number:

User Notice
All information, documentation, and specifications contained in this manual are 
subject to change without prior notification by the manufacturer. The 
manufacturer makes no representations or warranties, either expressed or 
implied, with respect to the contents hereof and specifically disclaims any 
warranties as to merchantability or fitness for any particular purpose. Any of the 
manufacturer's software described in this manual is sold or licensed as is. 
Should the programs prove defective following their purchase, the buyer (and 
not the manufacturer, its distributor, or its dealer), assumes the entire cost of all 
necessary servicing, repair and any incidental or consequential damages 
resulting from any defect in the software.

The manufacturer of this system is not responsible for any radio and/or TV 
interference caused by unauthorized modifications to this device. It is the 
responsibility of the user to correct such interference.

The manufacturer is not responsible for any damage incurred in the operation 
of this system if the correct operational voltage setting was not selected prior to 
operation. PLEASE VERIFY THAT THE VOLTAGE SETTING IS CORRECT 
BEFORE USE.

International http://eservice.aten.com 

International 886-2-8692-6959

China 86-400-810-0-810

Japan 81-3-5615-5811

Korea 82-2-467-6789

North America 1-888-999-ATEN ext 4988
1-949-428-1111
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Product Information

For information about all ATEN products and how they can help you connect 
without limits, visit ATEN on the Web or contact an ATEN Authorized Reseller. 
Visit ATEN on the Web for a list of locations and telephone numbers:

International http://www.aten.com

North America http://www.aten-usa.com
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About this Manual

This user manual explains how to configure control system projects and control 
interfaces for ATEN controllers, as well as how to use the control interface and 
diagnose issues. ATEN Control System supports the following software 
programs to achieve these purposes:

Note: The product may be updated, with features and functions added, 
improved, or removed since the release of this manual. For an up-to-date user 
manual, visit http://www.aten.com/global/en/

Software/Application Description

ATEN Configurator An application used for creating and configuring control 
system projects, control functions, and visual design of 
control interfaces (Viewers).

Database Generator A repository used for creating and storing drivers and 
operation commands of controlled devices for reuse when 
configuring Viewers using ATEN Configurator.

ControlAssist An application installed at a PC for it to be remotely control by 
ATEN Control System.

Control System App
(Viewer)

An application for controlling equipment managed by ATEN 
controllers via mobile devices or other supported control 
interfaces (e.g., ATEN Keypad, Control Pad, or Touch Panel).

DebugAssist An application that helps system administrators identify, 
analyze, and diagnose issues with ATEN control system.

http://www.aten.com/global/en/
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Conventions
This manual uses the following conventions:

Monospaced Indicates text that you should key in.

[ ] Indicates keys you should press. For example, [Enter] means to press 
the Enter key. If keys need to be chorded, they appear together in the 
same bracket with a plus sign between them: [Ctrl+Alt].

1. Numbered lists represent procedures with sequential steps.

♦ Bullet lists provide information, but do not involve sequential steps.

> Indicates consecutive selecting options (such as on a menu or dialog 
box). For example, Start > Run means to open the Start menu, and 
then select Run.

Indicates critical information.
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Terminology

Terminology Description

ATEN Controller, 
controller

ATEN Controller or controller refers to all models of ATEN 
Control Box and ATEN Control Pad.

Control Box Gen. 2, 
Control Box

Control Box Gen. 2 or Control Box refers to all models of ATEN 
Control Box Gen.2.

controller A controller refers to any model of ATEN Control Box Gen. 2 or 
Control Pad.

Viewer A Viewer is a software control interface that system operators 
use to control and operate devices managed by ATEN control 
system. The Viewer is fully configurable and customizable using 
ATEN Configurator. For example:

Project A project is a configuration file, generated using ATEN 
Configurator to specify settings of an ATEN Control System, 
including one or multiple controllers, managed devices, and 
control interfaces.
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What’s New in Configurator (v.4.0)

New & Improved Features For More Information

Project import to enable reuse of existing project 
setups

See Import Project, page 14.

Supports SSH-enabled Ethernet devices See Ethernet Device Properties, 
page 34.
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Chapter 1
Introduction
This chapter provides an overview of ATEN Control System and its supported 
software:

 Overview

 Benefits

 Features

 Compatible Products and Accessories

Overview
The ATEN Control System is an Ethernet-based management system that 
incorporates ATEN controllers (ATEN Control Box and/or ATEN Control Pad) 
and control interfaces (ATEN Keypads and ATEN Touch Panel) for connection, 
configuration, and operation of all hardware devices in a room or large facility to 
provide convenient control effortlessly via a mobile device or an ATEN Touch 
Panel. The ATEN controller works as the main controller that provides 
connectivity to hardware devices commonly seen in settings such as meeting 
rooms, conferences, boardrooms, and classrooms. 

After connecting the hardware, the ATEN Configurator (VK6000) provides 
simple setup of the devices with easy step-by-step configuration. The ATEN 
Touch Panel and ATEN Control System app, for iOS, Android or Windows 
mobile devices, then empowers you with the mobility to control all hardware 
devices remotely, whenever and however you like.

ATEN Control Box/Control Pad can be easily deployed into an existing 
installation and integrate seamlessly with ATEN VanCryst pro-AV products and 
nearly any other hardware devices found in a room, including AV equipment, 
lighting, conference systems, air conditioning, motion sensors, power switches 
and many more. The controller serves as the central platform where hardware 
devices are connected — to be monitored, managed, and controlled directly via 
a tailor-made GUI — a Viewer — from any iOS, Android, or Windows mobile 
device or an ATEN Touch Panel.
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The control system project and its control interface is configured using an 
intuitive program — the ATEN Configurator (VK6000). The ATEN Configurator 
walks you through configuring the hardware, designing the control interface 
(Viewer), and uploading this configuration to the controller. Through an Ethernet 
connection, the ATEN Control System app enables you to edit and download 
Viewers from the controller via a point-n-tap user interface. The use of each 
Viewer is protected with password authentication to ensure secure access.

The ATEN Control System is the perfect solution for any meeting rooms, 
conferences, boardrooms, classrooms, and any other room setting that requires 
a centralized, mobile control of a variety of hardware devices through 
streamlined Ethernet-based management system with optimum efficiency and 
performance.

Benefits

Intelligent Control
The ATEN Control System makes the interactions between your hardware 
devices smarter. Programmable actions and triggers provide a fully automated 
series of advanced operations that allow your devices to respond to each other 
intelligently, making your meeting solution run smarter and smoother.

Optimized Performance
The ATEN Control System offers communication protocol optimization that not 
only maintains a near-zero response time but also features data encryption for 
ensured protection.

Simplified Setup
No matter how large the room or how complicated the hardware, the ATEN 
Control System can be deployed in 3 easy steps: connecting the hardware, 
configuring the system, and uploading Viewers for remote control access. 
Through an intuitive GUI, the process for setting up the controls for every room 
is simple and customizable, which is fulfilled via straightforward, predefined 
commands and macros that do not require programming skills.
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Effortless Expandability
With a range of expansion boxes available, the ATEN Control System 
installation can be expanded to accommodate additional hardware devices with 
various interfaces, such as serial, relay, and IR. In addition, the ATEN Library is 
preloaded with 10,000+ device drivers, and can also be expanded freely by 
adding new device drivers through the Database Generator for convenient 
management, however the size or scope of the installation may be.

User-Oriented Convenience
With its advanced, single-software design, the ATEN Control System offers a 
comprehensive library of actions and design elements for creating intuitive 
control panel interfaces for convenient, customizable remote access and control 
by any mobile device. Various support services also provided with the solution 
include driver downloads, database generation, upgrade tools, etc. — to help 
system integrators build easy-to-control applications in a wide range of 
scenarios effortlessly.

On-the-Go Control
Intuitive system control can start from one room and scale up to multiple rooms, 
both within the same area and even across regions. Different rooms can be 
effectively controlled by switching between Viewers, with simple point-n-tap 
operations, on an iOS, Android and/or Windows mobile. For optimal flexibility, 
multiple mobile devices can be authorized to control the same room or multiple 
rooms, providing enhanced mobility.
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Features

ATEN Configurator
 Simple profile setup with easy configuration steps via intuitive GUI

 Customizable profile templates to be used on mobile devices and PC

 Supports ControlAssist that allows PC control (PC shutdown, media files, 
PowerPoint files)

Note: For details on the supported PC control actions, see Supported PC 
Control Actions, page 210. 

 Supports Pronto formatted IR codes – IR command codes can be entered 
in Hex format

 Supports Modbus protocol – enables integration with Modbus devices, 
including TCP, RTU and its checksum data

 Supports Telnet CLI (command-line interface) mode for third-party system 
integration

 Built-in Database Generator for device driver setup and overall device 
management

 Built-in ATEN Library comprising 10,000+ device drivers and complete 
ATEN Pro AV product drivers

 Scheduling for repeating events

 Programming-based Script Editor for complex monitoring scenario handling

 Two-way communication enables user-defined event monitoring to 
automatically trigger the next actions

 Status synchronization of managed devices across multiple mobile devices

 Supports status monitoring and action control configurations of third 
devices implemented on ATEN Unizon.2

 Allows for Display Real-time Streaming Protocol (RTSP) and ATEN VE89 
series video

 Test tool to verify commands in action before uploading the profile to the VK 
series controllers

 Simulator to simulate and review the customized GUI before uploading
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Database Generator
 Built-in 10,000+ device drivers include ATEN products

 Allows users to create device drivers for different control interfaces, 
including Serial, IR, DO, Relay, and Ethernet

 Supports IR learning function for adding IR device drivers

 Built-in with default template for IR device

 Supports a variety of formulas that simplify complicated command codes

 Supports real-time command testing

 Allows TCP, UDP, Telnet, HTTP, HTTPS and WebSocket driver creation

 Supports Quick Mode for IR grouping test

 Flexible device driver import and export

 Enables user to edit the feedback processing of the device in LUA scripts 
and save it to a database for use in ATEN Configurator

ATEN Control System App
 Allows administrators central control of multiple rooms via Viewers on a 

mobile device or tablet computer
 Restrict user access to Viewers via password authentication
 Synchronization of system controls amongst multiple mobile devices and 

tablet computers
 Any iOS, Android, or Windows mobile device can be used to control the 

system – no need to purchase costly exclusive user panels
 Supports demo mode to allow demonstration of the solution’s most 

important functions without the need to connect the touch panel to a 
controller

 Screen Saver helps save energy and prolongs the lifetime of the touch 
screen

 Supports Display Real-time Streaming Protocol (RTSP), ONVIF, and ATEN 
VE89 series video preview

Note: The function is only applicable to VK1200 / VK2200.
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ATEN ControlAssist
 Remote PC control function

 Remote PC shutdown*

 Remote browsing and control of media files

 Remote preview and control of PowerPoint files

 Remote PC volume control

 Remote execution of programs

 Remote opening of files and URLs

 Simulate hotkey combination for third-party software control

 Support Windows prompt commands

 Keep an application window on top of other windows

Compatible Products and Accessories
Maximize the efficiency and functionality of your Control System with a wide 
range of products and accessories, such as ATEN Unizon for centralized 
management, professional audio products for audio processing. For full 
information, visit the product page of your specific controller model or contact 
your local ATEN dealer.
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Chapter 2
ATEN Configurator 
ATEN Configurator is a GUI-based tool that helps you set up hardware to your 
ATEN Control System, and create control interfaces, Viewers, to be used on 
devices such as ATEN Keypads, ATEN Control Pads, ATEN Touch Panels, or 
mobile devices for management and control. 

This chapter provides the following information about ATEN Configurator:

 Installing ATEN Configurator

 Getting Started Tasks

 Main Screen

 Creating Projects

 Configuring Controller-Managed Devices

 Device Library

 Configuring the Control Interface (Viewer)

 Button / Slider Bar / Dial Kit Actions

 Design Library

 Centralized Monitoring and Control via Unizon™

 Uploading Viewers
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Installing ATEN Configurator
To install the ATEN Configurator software, do the following:

1. Download ATEN Configurator.

a) Visit the ATEN download page.
http://www.aten.com/global/en/support-and-downloads/downloads/

b) Search for “VK6000”. A list of downloads for VK6000 appear.

c) Click ATEN_configurator_software_x.x.xxx.zip to download.

2. Open the downloaded zip file and double-click 
ATEN_configurator_software_x.x.xxx.exe to run the setup. This screen 
appears.

http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
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3. Click Next. This screen appears.

4. If you agree with the License Agreement, select I accept the terms of the 
license agreement, and click Next. Click Print to print the Software End 
User License Agreement. This screen appears.
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5. To change the destination location, click Change. Click Next to proceed 
using the default location. This screen appears.

6. Click Install. When the process is complete, a confirmation message 
appears.

7. Click Finish.
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Getting Started Tasks
After you have installed and launched the ATEN Configurator, the main screen 
(page 13) appears. You will be guided to create and configure a project using 
the 4 tabs in the Configurator’s interface, as illustrated below. 

Hint: You can click the tabs to switch among different pages for configuration. 

The steps below provides an overview of the getting started tasks.

1. In the Project tab, do the following.
 Provide information about the ATEN controller that you have set up.
 (Optional) Provide client information for the specified ATEN controller.
Click Add Controller if you have more than one controller in the 
environment.

Click Start Project to proceed.

2. In the Device tab, do the following.
 Connect each controller with its managed devices by adding them to 

the controller’s Device List, enter the connection settings, and specify 
the physical locations.

 (Optional) Add another controller and/or Expansion Box to the project 
by clicking Add Controller or Expander.

 Connect the Expansion Box with its managed devices by adding them 
to the Device List. 

For more details, see Configuring Controller-Managed Devices, page 23.

Click Design or the Viewer tab to proceed.

3. In the Design tab, do the following.
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 Create and configure a control interface (Viewer). For more information, 
see Configuring the Control Interface (Viewer), page 43.

 (Optional) Set up scheduled events to automatically carry out specified 
actions.

 (Optional) Add additional conditions and actions to buttons using Flags. 
For details, see Flag, page 120.

 (Optional) Create a sequence of actions for a button by creating a 
Macro. For details, see Macro, page 144.

 (Optional) Create a Variable for a device setting that is controlled by two 
or more objects in one control interface. For details, see Variables, 
page 148.

4. In the Upload tab, upload this Viewer to the controller. For details, see 
Uploading Viewers, page 171.
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Main Screen

Overview
Double-click the Configurator.exe shortcut to open the ATEN Configurator 
software. The Project page appears:

No. Control Description

1 Menu Bar The menu bar contains a group of the Configurator ‘s main 
functions by category. For details, see Menu Bar, page 14.

2 Project Bar The Project Bar contains four tab and the Library icon. Each tab 
relates to a step required to set up the project. Each step and 
the Library can be selected by clicking on the bar. 

3 Interactive 
Display Panel

This is the main work area. The page that appears here reflects 
the project tab that is selected. 

4 Library The Library contains the devices, graphic, flag, macro, and 
monitor databases. Each section allows you to add custom 
items or choose from ready-made selections.

5 Toggle Bar These three icons are used as a toggle to show or hide the right, 
left and bottom control panel. 

6 Simulator The Simulator button is used to test the Viewer after it is created 
in Design. The simulator allows you to try out the interface as it 
would work on a mobile device but without actually controlling 
devices. Use the mouse to click through the page links. 

1
1 2 3 4 5 6
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Menu Bar
The menu bar contains the Configurator’s main functions arranged by category. 
Refer to the table below to find out what each function does.

Menu Sub-Menu Description

File New Project Select to create a new project. 

Open Project Select to browse and open a previously 
saved project. 

Import Project Imports a project file.
Note: Make sure that the target 
controller contains sufficient number of 
ports and allowance of library items (e.g. 
monitoring events, variables, etc.) for 
the imported profile file. For the 
maximum number of connection ports 
and library items, see Control System 
Project Specifications, page 272.

Restore Project from Controller Downloads a previously backed up 
project from a controller.

Close Closes the current project and returns to 
the Project tab. 

Save Select to save changes to the current 
project. 

Save as Use this option to save the project as a 
different name.

Export Viewer to USB
(Not supported by ATEN Control 
Pad)

Exports Viewers and an access key to a 
USB drive. After exporting the data onto 
a USB drive, plug the USB drive into the 
Control Box’s USB port to upload the 
Viewer files and the access key. These 
files can only be read by the Control Box 
and are not project files that can be 
opened by the ATEN Configurator 
software.

Project Report Click to save a PDF file that contains 
detailed information about each part of 
the current project.

Add KNX 
Device

Import ETS 
Project

Import an ETS project file for your KNX 
devices. 

Add Custom KNX 
Device

Click to add a KNX device. For more 
details, see Adding KNX Devices, 
page 28.

Recent Projects Select to view a list of recent projects 
that can be clicked on to open. 

Exit Select to close the project and exit.



Chapter 2. ATEN Configurator

15

Edit Undo Select to undo a change when editing a 
Viewer in Create & Design Viewer.

Redo Select to redo a change when editing a 
Viewer page in Create & Design Viewer.

Cut/Copy/Paste Select to cut, copy or paste text and 
objects when editing a Viewer page in 
Create & Design Viewer. When used to 
copy and paste a button, both the 
General and Action properties are 
copied. 

Paste Graphic Only Select to paste a button’s image but not 
its Action properties in Create & Design 
Viewer.

Delete Select to delete highlighted text and 
images when editing a page in Create & 
Design Viewer.

Delete Action Only Select to delete the Action properties of 
a button in Create & Design Viewer.

Select All / Deselect All Use either option to select or unselect 
all objects when editing a viewer page in 
Create & Design Viewer.

Preferences Display 
Language

Use to select the language for the 
interface.

SSH Destination Click to choose the location of the 
executable for the SSH Client software. 
To execute the program, go to Tools > 
SSH Client.

Interface Check a box to enable the feature 
described below:
 Show Welcome Page: displays the 

Welcome screen when the ATEN 
Configurator software opens. 
 Auto Page Creation: automatically 

creates a Viewer page in Create 
Viewer & Design, for every hardware 
device that is configured in Select 
Device & Configuration.
 Show Password: displays the 

characters of the access key in the 
Edit Access Key dialog box.
 Automatically check for updates: 

automatically checks for updates and 
notify the user when an update is 
available.

Menu Sub-Menu Description
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View These options are available from Create Viewer & Design Edit Viewer.

Zoom Zooms the Viewer page to 25%, 50%, 
75%, 100%, 200% or Fit in Window. 
Note: A mouse wheel can be used to 
zoom the Viewer page in or out. 

Project Information Select to go to Project Information.

Device Configuration Select to go to Select Device & 
Configuration.

Viewer Design Select to go to Create Viewer & Design. 

Project Upload Select to go to Search & Upload. 

Properties Select to show/hide the Properties 
window when editing a Viewer page.

Align to Grid Select to automatically align objects with 
the grid. This places objects in perfect 
alignment with the grid dots when they 
are moved. Use Show Grid to display 
the grid dots. When Align to Grid is not 
selected, objects can be placed 
anywhere on the page.

Show Grid Select to display the grid dots on the 
page. Use with the Align to Grid option 
to set objects in perfect alignment on the 
page. 

Show Object ID Select to show object ID at the top-right 
corner of each object. An object ID is 
used to specify an object in some 
configuration.

Object Button Adds a button to the Viewer page. 

Label Adds a label to the Viewer page.

Image Adds an image to the Viewer page. 

Scroll View Adds a scroll box to the Viewer page, 
then double-click it to add buttons. Use 
the box as a scroll window to easily 
access a list of buttons on the page. 

Video Adds a video box which allows you to 
view video. The video box can be 
resized using the Properties sidebar or 
by dragging a small box on the boarder 
to resize it to the desired shape. 

Slider Bar Adds a slider bar to the Viewer page. 
Slider bars are used to adjust the value 
of a device setting, such as the volume 
level of an audio device. 

Menu Sub-Menu Description
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Object PowerPoint Control Template Adds a PowerPoint Control template to 
the Viewer. This control template is used 
to control PowerPoint files saved in a 
target computer.

Media Control Template Adds a Media Control template to the 
Viewer. This control template is used to 
control media files saved in a target 
computer.

Line Adds a line to visually separate objects 
on the Viewer.

Frame Adds a frame to visually frame an object 
or to group a set of objects in the 
Viewer.

Dial Kit Adds a dial kit to the Viewer. The dial kit 
can be used for dialing a meeting.

iFrame Adds an iFrame to allow switching of 
multiple pages on a defined area of a 
page or Home page.

Webview Adds the web view based on a user-
specified URL to the Viewer.

QR code Adds a QR code based on a user-
specified URL to the Viewer. 

Group Group Select multiple objects and use Group 
to lock them together. Objects in the 
group will move together as one.

Radio Group Select multiple buttons and use Radio 
Group to associate them as follows: 
selecting a button that belongs to the 
radio group deselects the previously 
selected radio button within the same 
group. 

Ungroup Select grouped objects and use 
Ungroup to unlock the group.

Order Bring to Front Moves an object to the top position 
when objects are layered.

Send to Back Moves an object to the bottom position 
when objects are layered. 

Bring Forward Moves an object up one position when 
objects are layered. 

Send Backward Moves an object down one position 
when objects are layered. 

Menu Sub-Menu Description
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Object Align Left Aligns two or more selected objects to 
the Left side of the object that is 
selected last. 

Center Aligns two or more selected objects to 
the horizontal position of the object that 
is selected last. 

Right Aligns two or more selected objects to 
the Right side of the object that is 
selected last. 

Top Aligns two or more selected objects to 
the Top side of the object that is 
selected last. 

Middle Aligns two or more selected objects to 
the vertical position of the object that is 
selected last. 

Bottom Aligns two or more selected objects to 
the Bottom side of the object that is 
selected last. 

Make Same 
Size

Width Resizes two or more selected objects to 
the same width of the object that is 
selected last. 

Height Resizes two or more selected objects to 
the same height of the object that is 
selected last. 

Both Resizes two or more selected objects to 
the same width and height of the object 
that is selected last. 

Space Evenly Across Page 
Width

Spaces two or more selected objects 
evenly across the width of the page.

Across Page 
Height

Spaces two or more selected objects 
evenly across the height of the page.

Between Objects 
Horizontally

Adjusts the horizontal space between 
three or more selected objects to the 
average distance between each of the 
selected objects.

Between Objects 
Vertically 

Adjusts the vertical space between three 
or more selected objects to the average 
distance between each of the selected 
objects.

Menu Sub-Menu Description
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Tools Database Generator Opens the ATEN Database Generator 
which is used to manually add and 
configure hardware devices. This is 
where you can create custom devices to 
add to My Device Library. See ATEN 
Database Generator, page 174, for 
details.

Simulator The Simulator is used to test a Viewer’s 
interface after it has been created in 
Design. The simulator allows you to 
tryout the interface as it would work on a 
mobile device but without actually 
controlling devices. Use the mouse to 
click through the page links.

SSH Client This runs the SSH Client software 
selected under Edit > Preferences > 
SSH Destination. The SSH Client is 
used to communicate with the controller. 

Windows New Page Click to create a new Viewer page or 
select a page to open in Create Viewer 
& Design.

Help About Provides the firmware version and 
support information for the Configurator 
software. 

Check for Updates Checks if ATEN Configurator is up-to-
date.

Training Videos (Basic) Click to see how-to videos on tasks 
involved in configuring a project file.

Training Videos (Advanced) Click to see how-to videos on using 
advanced features such as creating a 
variable, creating a driver using 
database generator, and more.

Driver Downloads Click to download drivers for third-party 
devices.

What’s New Click to see new features and functions 
in this version.

Menu Sub-Menu Description
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Creating Projects
The Project tab allows you to enter details about the installation to start the 
project. Enter the information using the table below as a guide.

Control Description

Name Enter the project name you are setting up. You can create 
multiple projects but for most installations only one project is 
required. 
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Controller Mode Click to specify how controllers in this project file connect to 
Expansion Boxes and Keypads.

 ID Mode (default)

 Controllers connect to Expansion Boxes or ATEN 
Keypads by matching controller ID, as set using the 
controller ID switch on the controller panel and 
configured in the project file (see Controller ID field 
below) with the controller ID set on the Expansion Box 
or Keypad.

 Using the ID mode, a controller can connect up to 8 
Keypads of the same model and 8 Expansion Boxes of 
the same model.

 IP Mode
 Controllers connect to Expansion Boxes / ATEN 

Keypads through their IP address.
Note: When IP Mode is selected, controllers do not 
use any ID settings on ATEN Keypads or Expansion 
Boxes as the basis for their connection. However, the 
controller ID on the controller panel and the project file 
need to match to successfully apply the configuration.

 Using the IP mode, the maximum numbers of ATEN 
Expansion Boxes that controllers can connect are as 
follows:
 VK0100 / VK0200: 16

 VK1100A / VK2100A: 32

 VK1200 / VK2200: 64

 Using the IP mode, the maximum numbers of ATEN 
Keypads that controllers can connect are as follows:
 VK0100 / VK0200: 10

 VK1100A / VK2100A: 16

 VK1200 / VK2200: 32

Add Controller Click to add controllers to the project. The number added 
should match the number of controllers installed. A project can 
have up to 16 controllers.

Controller ID Displays the controller ID. Make sure the ID in this field 
matches the ID on the controller so that the project file will be 
uploaded to the specified controller.

ATEN Controller Type Select the model for the controller. 

Control Description



Chapter 2. ATEN Configurator

22

Number of Rooms Enter the number of rooms each controller will control. Each 
hardware device you add will be associated with a room. When 
buttons are configured in the Design tab, you can select a 
Room under Button Action to filter the Device List so that only 
hardware in that room appears. This link between the 
controller, devices and room is how the Viewer knows which 
devices to control.

Name Enter the client name associated with the project.

Address Enter the client address associated with the project. 

Phone Enter the client phone number associated with the project. 

Remove Controller Click to delete a controller from the project.

Start Project Click to begin configuring hardware devices. The Select Device 
& Configuration tab will open. 

Control Description
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Configuring Controller-Managed Devices

The Device Tab
The Device tab is used to configure controller ports according to the connected 
hardware device. 

Control Description

Device List This section lists the ports for each controller, their connected device, 
connection mode, device location (room) and if the device is managed 
by Unizon™. Click on a controller, expansion box or Room in the left 
sidebar to display the ports. Each port needs to be configured 
according to the hardware device connected to it. For details, see Left 
Sidebar, page 24.

Left Sidebar The left sidebar provides a tree view of the ATEN Control System 
deployment in each project. Use the sidebar to add/remove a 
controller, Expansion Box, or Room.

Properties This section allows you to add and configure controllers, Expansion 
Boxes, managed devices, and rooms. For details, see Configuring the 
Control Interface (Viewer), page 43.
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Left Sidebar
Controller
The Left Sidebar provides a tree view of the controllers, Expansion Boxes, and 
rooms. Each controller in the tree view represents a controller with one or more 
rooms it manages. Selecting a controller allows you to configure its ports. When 
a port is configured for a device, it appears listed under the Room. 

Each controller must contain at least one room. When installing multiple 
controllers in one room, add a room with the same name to each controller. 

Each controller name ends with an ID number: e.g. VK2200-ID02. This ID 
number is automatically generated when the controller is added into the project. 
You can also configure this ID in the controller properties settings. 

Use this number to set the Controller ID Switch on the rear of the controller. 
This links the controller in the software to the physical device being installed.

Right-click a controller to Add Room or Delete Controller.

Room
Each room is associated with a controller and a Viewer so that the information 
is uploaded to the correct controller to control the hardware devices. Right click 
a room to Delete or Rename the room. Use the buttons at the bottom of the 
sidebar to Add Room. 

Expansion Box
ATEN Expansion Boxes connect over a network to add ports to the controller 
via its Ethernet port. Clicking Add Controller or Expander opens a window which 
allows you to select a device to add.

Device List
The Device list shows the controller ports by type. Click a port to view its 
Properties. Double-click a port to open the ATEN Device Library and search 

Device Library Click this icon to open the Library on the Device Library tab which 
contains a database of hardware devices that can be added to the 
Device List. For details, see Device Library, page 41.

Control Description
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for the hardware device to configure the port. Configure each port according to 
the hardware device connected to it.

Control Description

Type Lists the ports of the controller.

Device Lists the device name entered in Properties. 

Mode Lists the port’s communication mode. Click an arrow to select options:
 Serial: RS-232, RS-422, or RS-485

 I/O: Input (VDC), Input (Dry Contact) or Output

 IR: IR or R-S232

Room Lists the room selected for a device. The rooms available depend on the 
number of rooms added to the controller. No drop-down menu appears 
if there is only one room. Each controller must have at least one room. 
Select the room where the device is installed. 

Unizon™ Select this option to allow Unizon™ to manage and monitor the 
corresponding device.

Note: Configuration will also be required on Unizon™ for this feature to 
work. For an overview of how to set up the function, see Centralized 
Monitoring and Control via Unizon™, page 163.
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Adding Devices to the Device List

Adding Non-KNX-Compliant Devices to ATEN Configurator
To add devices that are not KNX compliant, use one of the following methods.

For a list of supported Datapoint Types (DPTs), see Datapoint Types (DPTs), 
page 273.

 Via ATEN Device Library or My Library

1. In the Device List, click a port where you have physically installed a device.

2. Click  library. In the pop-up window, click the drop-down list to select 
ATEN Device Library or My Device Library, and then double-click an item 
to add the device. The selected device is added to Device Configuration.

+ Add More 
Devices

RS-422, R-S485, LAN and IR ports can cascade additional devices that 
are connected to the first unit. IR ports can cascade 1 device, RS-422 
and RS-485 ports can cascade up to 2 devices and LAN ports can 
cascade up to 25 devices.

Control Description
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 Via the Properties Column

1. In the Device List, click a port where you have physically installed a device.

2. Use one of the following to add a device.
 Select from Library: 

Use this method to automatically bring in default settings for the 
selected device.

(a) Click the arrow button and select Add device from the Library to 
open the Library. 

(b) Click the drop-down list to select ATEN Device Library or My 
Device Library, and then double-click an item to add the device. 

 Specify and configure settings
Use this method to type and configure each setting for the device. 
When the configuration is complete, click Add Device.
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Note:

If the device is not in the Library, create the device using Database 
Generator. For details, see Editing / Adding a New Device, page 181.

Adding KNX Devices
There are two ways to add KNX devices into ATEN Control System projects:

 Add a KNX device individually (page 28)

 Import a pre-configured ETS project (page 29)

 Adding a KNX Device
1. In the Devices tab, go to File > Add KNX Device > Add Custom KNX 

Device. A KNX IP Interface (with a default room) is added.

2. On the controller where you wish to add the KNX device, right-click the 
controller and then select Add KNX Room > Default Room.
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The KNX device is added.

 Importing an ETS Project
1. In the Devices tab, go to File > Add KNX Device > Import ETS Project. 

The configurations for your KNX devices appear in the Controller tab on the 
left-side bar.

2. In the Controller tab, click on KNX IP Interface and type its IP address and 
port in the Properties column.

Device Properties
The Properties panel provides information and configuration fields for 
controllers, Expansion Boxes, remote devices, or rooms. Click a device or room 
from the left sidebar or the Device List to display its properties.

Controller Properties
Click a controller from the left sidebar or from the Device List to configure or view 
the following properties.

 Name: Displays the device model.

 Controller ID: Sets the controller ID. With the controller set to ID mode 
(Creating Projects, page 20), the controller connects to ATEN Expansion 
Box and Keypad by matching this ID with that set on the Expansion Box or 
Keypad.
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Expansion Box (Expander)
Click an expansion box from the left sidebar or from the Device  List to configure 
or view the following properties

 Name: Displays the device model.

 Expander ID: Select the expander ID. Make sure the ID matches the one 
set physically on the Expansion Box.

 IP Address: Specify the IP address of the expansion box. This setting is 
only required when the connection mode (with the controller) is set to IP 
mode. For more information, see Creating Projects, page 20.
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Serial Device Properties
Click a serial device from the Device List to configure its properties. 

 Name: Displays the device model.
 Add Device: Use this button to add devices. For details, see Adding 

Non-KNX-Compliant Devices to ATEN Configurator, page 26.
 Category: Displays the category of the selected device.
 Brand: Displays the brand of the selected device.
 Model: Displays the model of the selected device.

 Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Editing / Adding a New Device, 
page 181).

 Connection Settings: Click the drop-down lists to configure the baud rate, 
data bit, stop bit, parity settings, and flow control for the selected serial 
device.

 Advance Settings: Click Advanced to display the following settings.
 Delay Interval: Sets a time delay for each command before they are 

sent to the device.
 Feedback Timeout: Sets the maximum interval that the controller 

allows in between parts of a feedback message. The controller uses 
this value to identify the end of a message.

 End Character: Type the end-of-text character of the device to inform 
controller the end of a message and to shorten the response time.

 Keep Connection Alive: The controller sends a command to the serial 
device to maintain the connection and avoid timeout issues.

 Command: Type a command to be sent to the selected device.
 Interval: Type the interval at which the controller sends the 

command.
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I/O Device Properties
Click an I/O device from the Device List and select Input (VDC), Input (Dry 
Contact), or Output to configure its properties. 

 Name: Displays the device model.
 Add Device: Use this button to add devices. For details, see Adding 

Non-KNX-Compliant Devices to ATEN Configurator, page 26.
 Category: Displays the category of the selected device.
 Brand: Displays the brand of the selected device.
 Model: Displays the model of the selected device.

 Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Editing / Adding a New Device, 
page 181).

 Lower Threshold & Upper Threshold: Set the thresholds according to the 
hardware device you are connecting and then configure a Monitor (see 
page 122).

 Advance Settings: Click Advanced to display the Delay Interval setting.
 Delay Interval: Sets a time delay for each command before they are 

sent to the device.
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IR/Relay Device Properties
Click an IR/Relay device from the Device List to configure its properties. 

 Name: Displays the device model.
 Add Device: Use this button to add devices. For details, see Adding Non-

KNX-Compliant Devices to ATEN Configurator, page 26.
 Category: Displays the category of the selected device.
 Brand: Displays the brand of the selected device.
 Model: Displays the model of the selected device.

 Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Editing / Adding a New Device, 
page 181).

 Advance Settings: Click Advanced to display the Delay Interval setting.
 Delay Interval: Sets a time delay for each command before they are 

sent to the device.
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Ethernet Device Properties
Click an Ethernet device to configure its properties. 

 Name: Displays the device model.
 Add Device: Use this button to add devices. For details, see Adding Non-

KNX-Compliant Devices to ATEN Configurator, page 26.
 Category: Displays the category of the selected device.
 Brand: Displays the brand of the selected device.
 Model: Displays the model of the selected device.

 Version: Shows the firmware version selected for the device. Use the drop-
down menu to select a different firmware version. Click the menu box next 
to the version number to open a PDF with the version history. The version 
history and different versions for a device can be manually added/updated 
via the Database Generator (see step 3 of Editing / Adding a New Device, 
page 181).

 Connection Settings
Depending on the selected protocol, some of the following settings may not 
be required and are not displayed. 

 Protocol Type: Click to select the protocol for the Ethernet device. The 
ATEN Control System supports control of devices via ONVIF, TCP, 
UDP, HTTP, HTTPS, WebSocket, Telnet, and SSH. Configure the 
following fields as required.

 IP Address: Type to assign a fixed IP address to the Ethernet device.

 Port: Type to assign a communication port.

 Username & Password: Type the device’s login/access credentials. 

 VE Manager Password: Type the administrator password of the 
VE Manager to allow the controller to access video sources connected 
to the video extenders managed by the VE Manager.

 Auth Type: Sets the authentication type that the device uses. 

 URIPath: Type the part of the WebSocket URI that follows its 
communication port. For example, if the URI is 
wss://<host>:31416/Dicentis/API, type Dicentis/API in this field.

 SubProtocol: Type the subprotocol for the Ethernet device. This 
information shall be available in the device’s reference or user manual.

 WSS: Select to encrypt the WebSocket connection.

 Edit Additional Info: 
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 ExtHeader: Type the required data for handshake header.

 Extension: Type the required data for the Sec-WebSocket-
Extensions header field.

 Edit Login Command: Click to edit the login command.

 Monitor Connection
 Check Status (ICMP): Select this option to allow the controller to send 

control messages to receive connection status for this Ethernet device.
Note: To allow the online/offline status to be accessible to Unizon™ for 
remote management, select the Unizon™ checkbox that corresponds 
to the device in the Device List.

 NOP (for Telnet only): Select this option to send a no-operation 
command to the remote end of a telnet connection to maintain the 
connection status of the device with controller.

 Stream: To allow video streaming to the controller via RTSP, select this 
option and type the streaming IP address, port, and login credentials of the 
Ethernet device.

 Advance Settings: Click Advanced to display the Delay Interval setting.

 Delay Interval: Sets a time delay for each command before they are 
sent to the device.

 Delay after Login (for Telnet only): Sets a delay (to allow a 
connection to be established) before the First and Second Commands 
are sent to the device. 

 Feedback Timeout: Sets the maximum interval that the controller 
allows in between parts of a feedback message. The controller uses 
this value to identify the end of a message.

 End character: Type the end-of-text character of the device to inform 
controller the end of a message and to shorten the response time.

 Send command after connection (for Telnet and TCP only): Sends 
commands to the device after a successful connection has been 
established. 

 Format: Sets the command format.

 First Command: Sets the command.

 Second Command: Sets the second command.
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 Automatically reconnect if no return message is received: 
Select this option to continue reconnection attempts when no return 
message is received from the device.

 Keep Connection Alive (for Telnet and TCP only): The controller 
sends a command to the device to maintain the connection and avoid 
timeout issues.

 Command: Type a command to be sent to the selected device.

 Interval: Type the interval at which the controller sends the 
command.
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Replacing a Controller
Use this feature to help you easily replace a controller and retain the device 
configurations.

Note: Raw commands involving devices that do not exist in the Device List will 
be removed upon replacement.

1. Make sure the current device configuration conform to the following:
 The new controller is equipped with enough ports to accommodate the 

devices managed by your current controller.
 Since the replacement is carried out on a port to port basis, make sure 

the devices managed by your current controller are added to ports that 
also exist in the new controller.
For example, to replace a VK2200 (as shown below) with VK1200 
(equipped with only 2 serial ports), move the VM5808D on Serial 3 to 
either Serial 1 or Serial 2.

2. In the project file, go to the Device tab.

3. From the left sidebar, right-click on a controller you wish to replace and go 
to Replace Controller.
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4. From the pop-up menu, click to select a controller for replacement. For 
example, select VK2100A. A warning message about removing raw 
commands appears.

5. Click OK. The controller is immediately replaced with the device 
configuration retained.
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Moving a Controller-managed Device to another Controller
To move a controller-managed device, along with its configuration to another 
controller, follow the steps below.

1. In Configurator, click the Device tab.

2. In the left sidebar, right-click the device you wish to migrate, go to Move to, 
and then select a controller and a target port.

3. The device (along with its configuration) is moved immediately.
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Moving a Controller-managed Device to Another Room
To move a controller-managed device to another room (managed by the same 
controller), follow the steps below.

1. From the left sidebar, right-click the target device and go to Move to Room. 
A pop-up menu appears listing other rooms of the controller.

2. Click to select a destination room. The device is immediately moved. If no 
menu pops up, create a room first and try again.
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Device Library

The Project Bar provides the Library option. Use the Device Library 
tab (shown below) to configure controller ports according to the connected 
hardware devices. The Device Library provides an extensive database of 
hardware devices that can be double-clicked or drag-and-dropped into the 
Device Configuration page to configure controller ports. The Device Library is 
discussed on the next page.
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The Device Library tab is a database of hardware devices that instantly 
configure controller ports. Search the library for the device connected to a 
controller port then add it to configure the port. For devices not in the library, use 
the ATEN Database Generator to create custom hardware (see page 174). 
Click Library on the Project bar or double-click a port on the Device 
Configuration page to open the ATEN Device Library. 

 Add a device by clicking Add to Project or by drag & drop. 

 To search for a device type keywords into the box and click .

 Click a tab to filter by All, Serial, DO, IR, Relay or Ethernet.
 Click headings to sort by Brand, Device Type, Model or Version.

 Use the drop-down menu to select:
 ATEN Device Library – ATEN’s database of hardware devices. 
 My Device Library – Devices added from the Database Generator.
 Create Device – Opens the Database Generator to create custom 

hardware devices for My Device Library (page 175).
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Configuring the Control Interface (Viewer)
This section provides information on how to configure a control interface, the 
viewer, for your control system and the functions of different control objects.

Getting Started with Configuring Viewers

Step Action Refer to
1. Understand the usages of Pages and 

Subpages.
The Design Tab, page 44

2. Plan and consider the following 
before creating the viewer:

 required control actions and 
suitable control elements

 placement of these control 
elements among Pages, and on 
Subpages if needed

 Control Object Properties, 
page 63

 Viewer List, page 45

3. Create a viewer. Adding Viewers, page 49

4. Based on your planning, add the 
required Pages / Subpages.

 Adding / Removing a Page, 
page 53

 Configuring a Subpage, 
page 54

5. Add and configure control objects on 
the created Pages / Subpages.

 Configuring Control Objects, 
page 58
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The Design Tab
Use the Design tab to configure viewers for your control system. A design tab 
contains following elements to help you create, configure, and manage your 
viewers:

Viewer List

Control / Monitor List

Configuration Panel SimulatorLibrary11

2

3 4 5
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 Viewer List

The Viewer List provides a tree view of 
added Viewers and the associated control 
pages, as illustrated on the right. 

In a Viewer, you may find the following page types:
 Home Page: This is the main page (for mobile devices and ATEN touch 

panel) or the key layout (for ATEN Control Pads and Keypads). A Home 
Page typically contains buttons that redirect to frequently used features and 
control pages, such as display, lighting, air conditioning, etc.
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 Page: This is a full-size control page to which you can redirect by tapping 
an associated button or icon from the Home Page or other Pages.

 Subpage: A Subpage is a reduced-size control page that is embedded 
within a Home Page or Page through an adjustable frame (the green frame 
as illustrated below), called the iFrame. The advantage of using subpages 
is that it allows you to retain some elements of the page, such as buttons of 
a menu bar or a company logo, while switching among different subpages. 
In the example below, this page is designed to have a menu bar on the left 
and a reserved area (iFrame) for displaying three subpages that can be 
switched to by tapping the menu options on the left.

Use Viewer List to add, remove, or edit Viewers and the associated pages. More 
specifically, you can use the Viewer List to do the following tasks:
 To add a new Viewer, click the Add Viewer button.
 To add a new Page or Subpage, click the corresponding button at the 

bottom.
 To delete, rename, or copy an added page, right-click it from the list.
 To duplicate the visual design of a control page (without its configurations), 

right-click it to select Copy, and right-click the target Page or Subpage 
category and select Paste.

iFrame a subpage showing lighting controlsmenu bar
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 To open a control page, click the Page or Subpage from the Viewer list, the 
Page / Subpage appears as a separate tab in the configuration panel.

 To see a thumbnail of the added control pages within a Viewer, click a 
Viewer from the list. This Viewer appears as a tab in the configuration 
panel. For example:

 Monitor / Control List
The monitor / control list shows the functions and settings monitored or 
controlled by ATEN Unizon™, categorized by device type. For more information 
about remote management via ATEN Unizon™, see Centralized Monitoring and 
Control via Unizon™, page 163.
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 Configuration Panel

The configuration panel is where the Viewer overview and control pages open 
in tabs for configuration.

 Library

The Library is a repository of built-in and user-created features and functions, 
including graphics (page 117), flags (page 120), monitoring events (page 122), 
macros (page 144), schedules (page 146), and variables (page 148). For an 
overview of these functions, see Design Library, page 116.

 Simulator

Use the Simulator button to simulate the control elements on your Viewer 
(without actual effect on controller-managed devices). Use the mouse to click 
through the page links.

Note: To view how Subpages appear, click the iFrame of the Subpage and 
select the Subpage you want to preview for the Preview Subpage setting. Your 
configuration for the selected Subpage appears.
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Adding Viewers

Deciding How Many & What Viewer to Create
Scenario 1
If you have 4 control devices in your project – 
one ATEN Control Pad, two ATEN Keypads 
(sharing identical key layout and control 
functions with each other, but different with the 
Control Pad), and an iPad, you will need to 
create 3 viewers, as illustrated on the right.

Scenario 2
If you have 3 control devices in your project – one ATEN Control Pad and two 
ATEN Keypads (sharing identical key layout and control functions with each 
other and with the Control Pad), you will need to:
 create one viewer for Control Pad
 enable the Connect Keypad setting and specify the associated Keypads. 

This way, the two Keypads will share the layout and control functions 
specified in this Viewer.
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Configuring a Viewer
1. In the target project file, go to the Design tab. The Viewer Settings page 

appears. If not, click Add Viewer from the Viewer List.

2. Select the physical device for the Viewer.

3. Configure the settings for your selected device. 
 Mobile Device

Setting Description

Type Use this drop-down menu to select the mobile device that will 
be used to control hardware devices in a room. This sets the 
resolution for the Viewer to fit on the mobile device’s screen. 
Choose a Custom selection to configure a screen size with 
the Resolution drop-down menu below it.
Note: If you select Custom Windows Device – the Windows 
OS has a limitation for adding buttons to Viewers used on 
Windows mobile devices. See , page 275, for details. 

Orientation Select one of the following display orientation:

 Landscape: A horizontal display where the width is 
greater than the height.

 Portrait: A vertical display where the height is greater 
than the width.

Resolution Use this drop-down menu to set a custom screen resolution 
for the mobile device being used to control hardware devices. 
This option becomes available when you select one of the 
Custom selections from the Type drop-down menu. 

Display Aspect 
Ratio

Indicates the aspect ratio used for the selected device.
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 Keypad

 Control Pad

Setting Description

Model Specify the Keypad model.

Number of Keys Specify the total number of keys for your Keypad.

Layout Specify the Keypad layout. This setting should match the 
physical Keypad layout. Depending on the total number of 
keys the Keypad has, you may have 1 or multiple options 
for this setting.

Controller ID Select the ID number of the controller to which the Keypad 
will connect. This ID must match the controller ID set on 
the Keypad.

Keypad ID Select the Keypad, distinguished by its ID number to match 
the Keypad ID set on the Keypad. Up to 8 Keypads can 
connect to one controller.

blank field 
(after Keypad ID)

For controller to connect to the Keypad through the 
Keypad’s IP address, make sure the controller mode setting 
(in the Project tab) is set to IP mode, and type the IP 
address of the Keypad in this field.

Add Keypad Click Add Keypad to add one or more Keypads that will 
connect to the same controller and share identical key 
layout and control functions. 

Setting Description

Model Specify the model for the Control Pad.

Number of Keys Specify the total number of keys for your Control Pad.

Layout Specify the layout for the Control Pad. This setting should 
match the physical layout. Depending on the total number 
of keys the Control Pad has, you may have 1 or multiple 
options for this setting.

Controller ID Specify the ID of the Control Pad.

Connect Keypad Select this option if the connected Keypad(s) share 
identical key layout and control functions with the Control 
Pad.

Keypad ID Click the drop-down menu to specify the ID of the added 
Keypad.
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 Touch Panel

4. Click Done to save the configuration. An overview appears. 

blank field
(after Keypad ID)

(Optional) Type the IP address of the Keypad for the 
controller to identify and establish connection with. Use this 
feature when you have more than 16 Keypads in the 
project or when the network switch blocks multicast signals 
between the Keypad and the controller.

Add Keypad Click this button to add Keypad that connects to this 
Control Pad and shares identical key layout and control 
functions.

Setting Description

Type Use this drop-down menu to select the Touch Panel that 
will be used to control hardware devices in a room. 

Orientation Select one of the following display orientation:

 Landscape: A horizontal display where the width is 
greater than the height.

 Portrait: A vertical display where the height is greater 
than the width.

Resolution Indicates the screen resolution of the selected Touch 
Panel.

Display Aspect 
Ratio

Indicates the aspect ratio of the selected device.

Setting Description
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5. Add or remove the Pages / Subpages to your viewer as required.

Adding / Removing a Page

 To add a Page to a viewer, click  from the Viewer list or  
from the viewer’s Page Overview. 

 To remove a Page, do any of the following.
 In the viewer list, right-click the Page and select Delete.

 In Page Overview, click  for the associated Page to be removed.
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Configuring a Subpage 

1. Click the target viewer from the Viewer List, and then click  to 
add one or more Subpages to the selected viewer.

2. Make sure the Page contains an iFrame for displaying Subpage controls. If 
not, right-click within the Page and select Add iFrame. A green frame 
(iFrame) appears. 

3. Preview a Subpage within the iFrame.

a) Click within the iFrame. The iFrame border turns blue.
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b) Go to Properties > Preview Subpage, and select a Subpage that you 
have created. The Subpage appears in the selected iFrame.

4. Adjust the size and location of the iFrame.

 To move the iFrame, mouse over within the iFrame and then click-and-
drag the iFrame.

 To resize the iFrame, click within the iFrame, and drag-and-drop the 
sides or any of the corners to resize.

5. If you have two or more Subpages sharing an iFrame, create a button for 
switching to each of the Subpages.

a) Right-click within the page and select Add Button.

b) Configure the button properties as required.

c) Click the button, click Link Subpage, and then double-click a Subpage 
from the Function column to add the action. For example:

d) Proceed to configure each button. Now the control page should contain 
buttons that switch to the defined Subpage.
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For example:

6. If you wish to keep a set of controls on the Page and only have them shown 
when the iFrame is closed, follow the steps below to add and configure a 
button for this purpose.

a) Right-click within the page and select Add Button.

b) Configure the button properties as required.

c) Click the button in the preview area, and add a Link Subpage action of 
any Subpage.

d) Double-click the added command and select Hide and the iFrame to be 
hided. 

Note: The iFrame ID should match the ID indicated at the top-right corner 
of the iFrame in the preview area.
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Duplicating a Viewer
To duplicate the Viewer along with its Pages / Subpages, do the following.

1. Click the target viewer from the viewer list. The page overview appears.

2. Click . The selected viewer is duplicated.

Viewer Control Objects

Understanding Control Objects
The ATEN control system supports a wide range of control objects, such as 
buttons, slider bars, videos, and PowerPoint controls that you can use and 
customize.

Each button has a symbol in the top left corner to indicate:

 “A” the button’s actions are configured correctly. 

 “!” the button’s actions need to be modified or they will not work. 

 Buttons with no symbol indicate that functions have not been added to it. 
For details on adding functions, see Button / Slider Bar / Dial Kit Actions, 
page 87.
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Each object is identified by an ID at the top right corner. These IDs are assigned 
in the order of creation. These IDs help identify a label when configuring a 
Change Label (page 110) or a button when configuring a Change Button 
State (page 109).

Configuring Control Objects
1. Use one of the following methods to open the Page you wish to configure. 

 Click the Page from the Viewer List.

 Click its associated Viewer from the Viewer List to open the Page 

overview and then click  to open the Page.
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The Page opens in a tab. For example:

2. To add a control object, right-click any space in the Page, and select an 
object from the pop-up menu.

Note:
 For detailed information of each object type, see Control Object 

Properties, page 63.

 The Windows OS has a limitation when adding buttons to Viewer pages 
for use on Windows mobile devices. See , page 275, for details.
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3. Click on the added object to configure its settings and/or associated 
actions.

11 15

13

14

12
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No. Element Tasks
1 Configuration 

panel
Shows a preview of the selected Page. You can 
also do the following on the preview panel:

 To zoom in and out on the preview, scroll the 
mouse wheel.

 To relocate an object, drag-and-drop the 
object.

 To layer an object, right-click the object and 
set the Order options.

 To group multiple objects, drag the mouse to 
select the objects, right-click on any of the 
objects and select Group.

 To align object, drag the mouse to select the 
objects, right-click on any of the objects and 
select Align.

 To lock objects to their assigned locations, 
drag the mouse to select objects, right-click 
on any of the selected objects, and then 
select Lock. A lock icon appears in the 
bottom-left corner of each selected object.

Note: To unlock objects, right-click on one 
object at a time, and select unlock.

 To set objects in perfect alignment, use the 
View menu options to select Show Grid and 
Align to Grid.

2 Button Action or 
Slider Bar Action

Use this panel to define the functions of each 
button and slider bar. For detailed information, 
see Button / Slider Bar / Dial Kit Actions, page 87.
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3 Advanced 
functions

 To add additional conditions and actions to 
buttons, use the Flag function. For more 
information, see Flag, page 120.

 For a button to initiate a sequence of actions, 
create a Macro. For more information, see 
Macro, page 144.

4 Library Use Library to customize the appearance of the 
page and its buttons. For more information, see 
Device Library, page 41. 

5 Properties panel Use the panel to configure selected object 
properties. For detailed information about object 
properties, refer to the following sections:

 Note: The iFrame ID should match the ID 
indicated at the top-right corner of the iFrame 
in the preview area., page 56 

 Object Properties for ATEN Keypad / Control 
Pad, page 84

No. Element Tasks
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Control Object Properties

Buttons
The Button properties provide options to configure the appearance of a button, 
and the confirmation message and progress message before carrying out the 
associated action. 
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 Alignment – Aligns a group of objects. Select multiple objects for the 
buttons to become available:

 Mode 
Use this drop-down menu to select one of the following button types. 

 Normal – This is a button that stays the same when pressed.

 Toggle – for a button that switches between two images/colors to 
indicate the button status. This also splits the Commands list under 
Button Action (page 87) – to provide two commands for the button: 
Toggle ON and Toggle OFF. 

 Press and Release – for a button that switches between two images/
colors when pressed and released.This splits the Commands list under 
Button Action (page 87) to provide two commands for the button: 
Press and Release. 

 Long Press for a button that switches between two images/colors 
when pressed and released. This button continuously re-sends a 
command to a device as long as it is pressed, at the Interval specified 
(see Interval, below) and stops sending the command once the button 
is released. 

Note: Use the Normal or Long Press option to set the image/color of the 
button based on its status.

 Appearance
Click the Appearance tab to configure the look of the button.

Note: The Appearance settings are applicable to all button modes. 
However, the Appearance tab only exists for Normal and Toggle buttons to 
categorize different sets of settings.

 Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the Viewer page).

 Font – use the drop-down menu to select the font type. 

 Color – use the drop-down menu to change the color of the text.

 Size – enter a number (1-200) to set the size of the text for the 
button.
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 Format – formats text to Bold, Italic or Underline for the button. 

 Alignment – click a box to align the text Right, Center or Left; and 
Top, Middle or Bottom within the button box.

 Style – use the drop-down menu to select the style type. 

 Image – Select this option from the drop-down menu and click 
Normal and Pressed to import an image to use as the button’s 
standard background and when the button is pressed.

 Color – Select this option from the drop-down menu to use color 
blocks for the toggle button and configure the colors for the normal 
and pressed status.

 Transparency – enter a number (0-100) or use the slider-bar to set 
the transparency of the button.

 Send Command Every (Long Press mode buttons only) – use the 
drop-down menu to select the amount of time between each command 
that is sent (repeatedly) to the device while the button is pressed.

 Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. Click Reset 
Image Size to reset the button size.

 Reset Image Size – click to reset the button size.

 Set Sync Condition – automatically synchronizes the button setting 
to the selected variable. To create variables, see Variables, 
page 148.

 Use as status indicator  Select this option to disable the control 
functioning of the toggle button and use it as a status indicator, which 
changes its appearance as defined by the Style settings.

 Drag-and-drop – (only applicable to Normal type buttons) Allows drag-
and-drop actions such as source assignment to output devices.

 Execute first (only applicable to normal-mode buttons) – Select this 
option for the button to automatically initiate its actions (commands) 
when its located page opens.

 Restrict access to this button on ATEN Control System App with a 
password– Limit the use of the selected button by requesting a 
password when the button is tapped in the Viewer. To enable this 
function, click this option and type the password in the box below. 
Note: 
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 This function is only supported by the Normal and Toggle mode 
buttons (page 64).

 A valid password should not start or end with a space and should 
only contain upper-case alphabets, lower-case alphabets, 
numerals, and/or special characters including ()~:-_

 Dialog
Click the Dialog tab to set up a confirmation message that displays in the 
Viewer when the button is pressed. 

Note: The Dialog settings are only available for Normal and Toggle buttons. 

 Confirm the associated action with the following message when 
the button is pressed – Click the check box to enable this feature.

 Action – Select a button action (Toggle On or Toggle Off) to display 
the confirmation message.

 Content drop-down list – Select one of the following for customization.

 Background – Customize the wording for the confirmation 
message. Type the message in the Name field and optionally 
customize its font and style.

 OK – Customize the wording on the button for carrying out the 
associated action. Type in the Name field and optionally customize 
its font and style.

 Cancel – Customize the wording on the button for canceling the 
associated action. Type in the Name field and optionally customize 
its font and style.

 Message
Click the Message tab to set up a progress message that displays while 
the associated action is being carried out.

Note: The Message settings are only available for Normal and Toggle 
buttons. 

 Confirm the associated action with the following message when 
the button is pressed – Click the check box to enable this feature.

 Action – Select a button action (Toggle On or Toggle Off) for 
displaying the progress message.

 Content drop-down list – Select one of the following for customization.
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 Background – Configure the wording for the progress message. 
Type the message in the Name field and optionally customize its 
font and style.

 Progress Bar – Configure the display duration (in seconds), font, 
and color of the progress indicator.

Groups
You can unify the properties of two or more control objects (buttons, slider bars, 
etc.) at the same time. Depending on the elements that your group of objects 
have, different properties will be open for configuration.Use your mouse to drag 
and select the objects from a page, the properties that are open for configuration 
appear in the Properties column. 

For example, if you want to unify the text that appear on multiple buttons, drag 
and select these buttons and then configure their properties, as illustrated 
below.
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Labels
The Label properties provide settings for 
the displayed text and its format. 

Alignment – Aligns a group of objects. 
Select multiple objects for the buttons to 
become available:

Name – enter the text you want to use 
for the label or slow double-click the label 
on the Edit page.

Font – use the drop-down menu to 
select the font type. 

Color – use the drop-down menu to 
change the color of the text. 

Size – enter a number (1-200) to set the 
size of the text.

Format–  format text to Bold, Italic or 
Underline.

Alignment – click a box to align the text 
Right, Center or Left; and Top, Middle or 
Bottom within the label box.

Border/Line – select this option to 
configure the color, format, and width of 

the display screen border.

 Position and Size – X and Y position the label at the coordinates entered. 
Width and Height set the size of the label. 

 Set Sync Condition – Displays the value of the selected variable in 
percentage or its raw form. To create variables, see Variables, page 148. 
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Slider Bars
Right click on a Viewer page and select 
Slider Bar to add a bar. A Slider Bar can 
control a device, link to another page, or 
run a macro.

Use the Mode drop-down menu to select 
the type of slider bar (Basic Slider Bar 
or Advanced Slider Bar).

Basic Slider Bar

A slider bar where you enter the 
minimum and maximum values to 
calculate the range and levels on a slider 
bar, and then add one command to 
configure the Basic Slider Bar’s action 
(See Slider Value, page 94). Choose 
options under Value to configure the 
slider bar’s range.

Direction – sets the bearing of the 
slider bar. 

Style: 

To change the color of the slider bar, 
click the Style drop-down menu and 
select Color, and then click the 
Foreground Color and Background 
Color drop-down menus to set up the 
colors. 

To change the appearance of the slider 
bar, click the Style drop-down menu and 
select Image. And then click on the 
Track and Level images to browse and 
upload new images.

Value – Sets the total number of levels 
for the slider bar.

ASCII / HEX – click a radio button to 
select the format for the slider bar 
values. 
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 Minimum – enter the lowest level on the bar.

 Maximum – enter the highest level on the bar. 

 Level – this represents the number of levels on the slider bar. You can 
calculate the value of each level with the formula: Maximum Value - 
Minimum Value / Level = Value Per Level. The Level is automatically 
calculated according to the Minimum and Maximum values you enter. 

 Position and Size – depending on whether the bar is set Vertical or 
Horizontal you can use either the Size: Width or Height box to enter a 
number to resize the length of the slider bar. 

 Set Sync Condition – Automatically synchronizes the slider bar to the 
selected variable. To create a variable, see Variables, page 148. 

Advanced Slider Bar 

 A slider bar where you set the number of levels and add a command for 
each level in the bar (see Level, in the table, on page 87). Choose options 
under Value to configure the slider bar’s range:

 Direction – sets the bearing of the slider bar. 

 Style – click the drop-down menus to select the Foreground Color and 
Background Color for the slider bar.

 Value – Sets the total number of levels for the slider bar.Level – this 
represents the number of levels on the slider bar. For each level you must 
add a separate command in the Slider Bar Action – Commands list (see 
Level, in the table, on page 87). 
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PowerPoint Control and Media Control Templates
Click a PowerPoint control template or a 
media control template to configure its 
position, size, and the PC that controls it.

Position and Size – X and Y position 
the label at the coordinates entered. 
Width and Height set the size of the 
label. 

Select Device – Select the PC that 
stores the PowerPoint or media files 
using the drop-down list.
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Images
The Properties for an image provide options to change and import images to the 
page. Images can be layered with other objects so that they can be placed as a 
background or as highlights for buttons (see Layering Images, page 73). You 
can Group, Order, Align, Make Same Size or Space Evenly from the Object 
menu. 

Note: For imported images, make sure the file names contain English alphabets 
and/or numerals only.

Style – shows the image selected. 
Click inside the box to import an image 
(*.png,*.jpg,*.jpeg,*.bmp) to the page.

Transparency – enter a number (0-
100) or use the slider-bar to set the 
transparency of the image selected.

Position and Size – X and Y 
position the image at the coordinates 
entered. Width and Height set the size 
of the image. 

Reset Image Size – resets the 
image size. 
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Layering Images
Images can be layered with other objects, such as labels and buttons, so that 
they can be placed as a background or as highlight for the page and/or other 
objects.
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Videos
A video object is a control used for video preview, video assignment on 
managed displays, or video streaming by RTSP. For more details of each, see 
the corresponding section below:

 Video previews: See Setting Up a Video Preview Window, page 74.

 Video assignment: See Setting Up a Video Control Window, page 74.

 Video streaming: See Setting Up a Video Streaming Window, page 77.

Setting Up a Video Preview Window

You can set up video preview windows to view video sources from ONVIF-
compliant cameras managed by the controller. 

1. In your project file, make sure you have added ONVIF-compliant cameras 
as Ethernet devices in the Device List.

2. Right-click a viewer page and select Add Video. 

3. Click the added video object and configure the following properties.

 Mode: Select ONVIF.

 Position & Size: Configure these settings as required.

 Select Device: Select the added ONVIF-compliant camera.

Setting Up a Video Control Window

Video control windows are objects on the Viewer which allow you to see 
previews of video sources (on a source object) or the assigned video sources 
(on a display object), and to switch video sources by tapping or dragging and 
dropping actions from the Viewer. Note that video control window is only 
applicable to ATEN networked video extenders.

For example, the following Viewer contains 8 video control objects, the top 3 are 
video source objects, each show a preview of its connected video source, and 
the bottom 5 are display objects, each showing its assigned video source. 
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To switch a video source on a display, tap a source object and then tap a display 
object. The switch takes effect immediately. Alternatively, you can drag-and-
drop a source object onto a display object if you have this control action 
enabled.

To set up a video control object, follow the steps below.

1. In Configurator, you are advised to add at least one video transmitter as 
Ethernet device (to the Device List) for every 4 video control objects to use 
the as a gateway to obtain previews.
Important:

 Videos can only be transmitted via video transmitters to the controller. 

 To ensure preview quality:

 Add at least one video transmitter (to the Device List) for every 4 
video control objects. Adding more video control objects will likely 
reduce the refresh rate and smoothness of the preview.

 Avoid concurrent viewing from more than one user via the Control 
System App.

 Use the VE89 control app to preview video walls.

 To ensure stable preview delivery, it is recommended to use the 
windows version of the Control System App for prolonged viewing or 
monitoring. Prolonged viewing on iOS platforms may result in automatic 
termination of the process due to the platform’s protection mechanism 
to ensure its normal functioning.

2. Right-click a Viewer page and select Add Video. 
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3. Click the added object and configure its properties.

 Mode: Select VE89 Series.

 Position & Size: Configure these fields as required.

 Select Device: Select a video transmitter as the gateway for obtaining 
a preview of what is displayed on the specified extender (as configured 
for Port and ID). 
Important: Only connect up to 4 control objects to one device.

 Port: Select the device type. Select Transmitter for a source object 
and Receiver for a display object,

 ID: Type the device ID for the specific transmitter or receiver. Allow 
drag-and-drop: Select this option to allow drag-and-drop controls. 

4. Click the added object and configure the action.
For example: 

(a) Create a variable to store the video source on a source object. 

(b) Add the switching action on a display object.

For more information about creating actions, see Button / Slider Bar / Dial 
Kit Actions, page 87.
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Note:To ensure smoothness of video transmission, prevent accessing this 
Viewer page from two or more devices at the same time.

Setting Up a Video Streaming Window

You can set up a window to stream video content via RTSP.

1. In your project file, make sure you have added an RTSP-compliant device 
and configured the Stream settings.

2. In a Viewer page, right-click in the blank space and select Add Video.

3. Click the added video object, and configure its properties as follows.

 Mode: Select RTSP.

 Position & Size: (Optional) Specify the position and size as required. 
Alternatively, drag any of the object corners for resizing; mouse over the 
object to drag-and-drop it to reposition within the Viewer page.

 Select Device: Select the added Ethernet device.

 RTSP Settings
 Default: Select this option to use the typical format for the RTSP 

URL (rtsp://username: password@ip:port). Type the RTSP URL 
of the device in the blank below.

 Custom: Select this option to use a different RTSP URL format. 
Type the URL in the blank below.
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Dial Kit
A dial kit template consists of a display screen and a set of dial keys. To 
configure their appearance, click on the display area or a key. 

Display Screen

Dial Keys

Properties for Display Screen Properties for Dial Key
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 Font – use the drop-down menu to select the font for the typed text. 

 Color – use the drop-down menu to change the color of the text.

 Size – enter a number (1-200) to set the size of the text for the button.

 Format – formats text to Bold, Italic or Underline for the button. 

 Alignment – click a box to align the text Right, Center or Left; and Top, 
Middle or Bottom within the button box.

 Style – use the drop-down menu to select the style type. 

Note: The image and color settings are only applicable to dial keys.

 Image – select this option to import different images for the dial key 
when it is pressed and not pressed (normal). 

 Transparency– enter a number (0-100) or use the slider-bar to set 
the transparency of the button.

 Color – select this option to use different color blocks to indicate a 
pressed and a normal dial key. 

 Border/Line – select this option to configure the color, format, and 
width of the display screen border.

 Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. Click Reset 
Image Size to reset the button size.

Note: If you are using the Call  and End Call  dials, click the dial key to 
configure its action. For a detailed procedure, see Example: Configuring actions 
of dial keys., page 96.
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QR Code
Use a QR code object to provide quick access to web resources.

1. On a viewer page, right-click in any blank space, and then select Add QR 
code. A QR code object appears, encircled in blue.

2. From the settings panel, configure the properties as needed.

 Position and Size – X and Y position the 
object at the coordinates entered. Width 
and Height set the size of the QR code. 

Set Sync Condition – Automatically 
synchronizes the QR code to the selected 
variable. To create a variable, see 
Variables, page 148.

Enter the URL of the QR code to the blank 
space, as indicated in the screenshot.

3. To adjust the size, hold-and-drag on any spare icon on the blue frame.
For example:
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Webview
A webview object allows you to embed a web page to Control System Viewers, 
such as a web console of an ATEN device, making it easy to integrate control 
interfaces without configuring control functions from scratch.

For example, you can embed a mixer web console to Control System Viewer, 
as shown below.

To add a web view object:

1. On a viewer page, right-click in any blank space, and then select Add 
Webview. A webview object appears, encircled with a blue frame.

2. Configure its properties as needed.

 Position and Size – X and Y position 
the object at the coordinates entered. 
Width and Height set the size of the 
webview object. 

Enter the URL of the web page to the 
blank space, as indicated in the 
screenshot.



Chapter 2. ATEN Configurator

82

3. To adjust the size, hold-and-drag on any spare icon on the blue frame.
For example:



Chapter 2. ATEN Configurator

83

Frame & Line
Use frames and lines to visually group or separate control objects in your 
Viewer. Click a frame or line object to configure its properties.

 Style – configure the color, format, and width of the line or border of the 
frame.

 Rounder corder – use the scroll bar or the number box to configure the 
roundness of the frame corner.

 Fill – select this option to fill the frame with the selected color.

 Position and Size – X and Y position the frame/line at the coordinates 
entered. Width and Height set the size of the frame/line. 

Frame Properties Line Properties
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Object Properties for ATEN Keypad / Control Pad
After you have added a Viewer (page 49) for your Keypad / Control, you can 
start configuring the Viewer. In the Viewer page, click on a button to configure 
its settings. The following settings appear in the Properties panel.
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 Mode 
Use this drop-down menu to select one of the following button types. 

 Normal – This is a button that stays the same when pressed.

 Toggle – for a button that switches between two images/colors to 
indicate the button status. This also splits the Commands list under 
Button Action (page 87) – to provide two commands for the button: 
Toggle ON and Toggle OFF. 

 Press and Release – for a button that switches between two images/
colors when pressed and released.This splits the Commands list under 
Button Action (page 87) to provide two commands for the button: 
Press and Release. 

 Long Press for a button that switches between two images/colors 
when pressed and released. This button continuously re-sends a 
command to a device as long as it is pressed, at the Interval specified 
(see Interval, below) and stops sending the command once the button 
is released. 

Note: Use the Normal or Long Press option to set the image/color of the 
button based on its status.

 Name – (optional) type the text you want to use for the button (or slow 
double-click the button on the Viewer page).

 Font – use the drop-down menu to select the font type. 

 Color – use the drop-down menu to change the color of the text.

 Size – enter a number (1-200) to set the size of the text for the button.

 Format – formats text to Bold, Italic or Underline for the button. 

 Alignment – click a box to align the text Right, Center or Left; and Top, 
Middle or Bottom within the button box.

 Style – use the drop-down menu to select the style type. 

 Image – imports an image to use as the button’s standard background 
and click Pressed to import an image to use when the button is 
pressed.

 Color – allows you to use drop-down menus to select the buttons color 
for Normal and Pressed. 

 Transparency – enter a number (0-100) or use the slider-bar to set the 
transparency of the button.
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 Send Command After Holding – Sets the required time for holding the 
button to apply the action for which the button is configured.

 Position and Size – X and Y position the button at the coordinates 
entered. Width and Height set the size of the button box. 

 Set Sync Condition – Automatically synchronizes the button to the 
selected variable. To create a variable, see Variables, page 148. This 
option is only available for toggle buttons.
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Button / Slider Bar / Dial Kit Actions

Understanding Button/Slider Bar/Dial Kit Actions
After you have added a button, slider bar, or a dial kit on your Viewer, define the 
actions it initiates using the Button/Slider Bar Actions panel. To access the 
panel, click on a button, slider bar, or dial key in the Viewer. The Button/Slider 
Bar Action panel appears.

The Button/Slider Bar Actions panel consists of the following elements:

Setting Description
Device Lists the added devices and the advanced functions. 

Room Select the room that contains the devices the Viewer will 
control. Use this drop-down menu to select rooms in the 
KNX system and display KNX devices. The Viewer will 
only upload to a controller configured with the same Room 
name (see Left Sidebar, page 24). Select All Rooms to 
allow the Viewer to control all rooms. Selecting All Rooms 
will upload the Viewer to all controllers. 
The Accessible Room defines what Devices are available 
to configure new Actions in Button/Slider Bar Properties 
(see page 87). Only Devices listed under the same Room 
(see page 24) as the Viewer’s Accessible Room will be 
listed for use in Button/Slider Bar Properties. 
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Function Lists the supported functions for your chosen device or 
advanced option. Double-click a function to add it to the 
Command List, which shows a sequence of tasks to be 
executed when specified conditions are met for the 
button, slider bar, or dial key. For details on functions, see 
Functions, page 91.

Commands Lists the commands that initiate when the button or dial 
key is pressed. Device and Advanced Option functions 
can be added and associated in the Commands list 
together. Commands initiate in the order that they are 
added to the list. Right-click in the Commands list to use 
the menu selections: Move Up, Move Down, Copy, Paste, 
Delete, Save as Macro, or Test Tool. 

Toggle ON / 
Toggle OFF
or 
Press / Release

When the Button Mode (page 64) is set to Toggle or Press 
and Release, the Commands list splits to set the two c 
commands:
Toggle ON / Press – lists the commands that initiate 
when the button is first pressed or pressed and held.
Toggle OFF / Release – lists the commands that initiate 
when the button is pressed a second time (Toggle), or 
released (Press and Release). When the button is 
pressed again, Toggle ON initiates and the cycle repeats.

The Level drop-down menu appears when an Advanced 
Slider Bar is selected on the Viewer page. The number of 
levels in the drop-down menu reflect the Level set in the 
Advanced Slider Bar’s properties (page 70). Use the drop-
down menu to select a level and then add a command for 
each of the Advanced Slider Bar’s levels (see page 94 for 
details).

Use Move up to move an action up in the Commands list, 
or Move down to move an action down in the Commands 
list. 

Use Delete to remove an action from the Commands list. 

Use Save as Macro to save the commands in the 
Commands list as a macro. 

Setting Description
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You can configure a button with Device commands (On, Off, Stop, Play, etc.); 
as a Macro to send multiple commands to one or more devices; or as a Link to 
other Viewer pages. Advanced Options allow you to add conditions to the 
commands, as described on the next page. 

Use Test Tool to connect to a controller and test the 
action(s) in the Commands list. 

Setting Description
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Configuring Button/Slider Bar Actions
To add one or more actions to a button, slider bar, or dial key, follow the steps 
below.

1. In the project file, click to select the button, slider bar, or dial key in the 
Viewer. The Button/Slider Bar Action panel appears.

2. In the Button/Slider Bar Action panel, select a Room.

3. Add commands. 
For details on device functions and advanced functions, see Functions, 
page 91.

a) Click a device or an advanced option to display its supported functions.

b) Double-click a function to add it to the Commands list.

c) Repeat step 3a and 3b if you wish to initiate a sequence of actions.

4. In the Commands list, double-click the commands to configure them. 
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Functions
Button/slider bar functions can be understood as device functions and 
advanced functions.

 Device functions – These are functions that the selected controller or a 
device managed by the controller initiates. The supported device functions 
vary depending on the device you select in the Device List, as illustrated 
below. For details on controller functions, see Device Functions, page 93.
Controller functions

VM3404H functions
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 Advanced functions – These are functions that involve more than one 
devices in the project. Use the indicated column to select an advanced 
function, the available options are listed in the Function list. For details 
about each advanced function, see Advanced Functions, page 97.
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Device Functions
 Each ATEN controller supports the following functions.

 Delay – adds a delay in seconds. Enter a number between 0.1-180. 

 Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 

 DO – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

 Wake on LAN – powers on the specified computer (MAC address) over 
Ethernet.

 Serial Raw (ASCII) – adds a serial command in the ASCII mode.

 Serial Raw (HEX) – adds a serial command in the HEX mode. 

 Telnet Raw (ASCII) – adds a telnet command in the ASCII mode.

 TCP Raw (ASCII) – adds a TCP command in the ASCII mode. 

 TCP Raw (HEX) – adds a TCP command in the HEX mode. 

 UDP Raw (ASCII) – adds a UDP command in the ASCII mode.

 UDP Raw (HEX) – adds a UDP command in the HEX mode.

 HTTP – adds an HTTP command.

 HTTPS – adds an HTTPS command.

 Pronto Hex Code – adds an IR command using Pronto Hex codes.

 KNX Raw – adds a KNX raw command. Note that this type of 
commands can only be used on a custom KNX device. For details 
about adding a KNX device to ATEN Control System, see Adding KNX 
Devices, page 28.

 SSH Raw – adds an SSH command in the ASCII mode.

 Value Types
When a device command has multiple values you can double-click it and 
use the Show Flag Menu* to select a device setting:
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  Library Value – use the drop-down menu to select a 
device setting for the command. The selection of settings in the drop-
down menu can be modified using the Database Generator to edit the 
command string (see Editing / Adding a New Device, page 181).

  Flag Variable – clicking this button allows a Flag 
with a set of values to be selected for the action. The button’s action will 
select a setting according to the Flag value. Each value in a Flag can be 
set to a different device using a Set Flag (as a button to select the 
device). When that (Set Flag) button is pressed, the Flag value is set for 
that particular device, and will be used as the setting for this action, 
when it’s button is pressed. 

  Variables – Select this option to use a Variable in 
the command. After selecting the option, a drop-down menu containing 
a list of the Variables that you created appear. 

  Slider Value – select this option to configure a Basic 
Slider Bar’s command. The range and change levels are automatically 
configured according to the minimum and maximum values set for the 
Basic Slider Bar. This option only appears when a Basic Slider Bar is 
selected on the Viewer page and you are adding Slider Bar Action 
commands. 

Note:The Show Flag Menu allows you to use a single Flag for all devices 
rather than adding a Conditional Flag for each device.

  Dial Value – select this option to use the string of 
values that has been dialed using the dial kit via Viewer from a mobile 
device. 

  Level – When an Advanced Slider Bar is selected on a 
Viewer page, the Level drop-down menu appears above the 
Commands list. A command must be added to each level of an 
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Advanced Slider Bar. To configure each level, use the drop-down menu 
to select a level and then add a command to it.
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Applications of Device Functions

Example: Configuring actions of dial keys.
Out of the 15 keys on a dial kit, only the Call  and End Call  keys require 
configuration, the actions for other keys are pre-configured to send out the 
number or character as indicated on the keys. 

Follow the steps below to add an action to the Call key.

1. Click the Call key  in the Viewer to display the Button Action panel.

2. Select a device (e.g. a video conferencing system) and double-click to add 
a function for the key. In this case, it should be a dialing function.

3. Double-click the added command and select Dial Value.

Display Screen

Dial Keys
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Advanced Functions
Use advanced options for button/slider actions that involve a series of actions 
(Macro), actions that the involve page redirect (Link), or actions that involve 
change or update of device settings of multiple objects (Set Variable).

Note:Associate Set Flag, Condition, Change Button State, or Change Label 
commands with device commands in the Commands list by dragging and 
dropping them into a tree view list, which allows them to initiate together (see 
Applications of Advanced Functions, page 103).

 Macro – sends multiple commands to one or more devices. Select to add a 
macro command from the Function list. To create a macro, add multiple 

device actions to the Commands list, then click the Save as Macro  

icon or access the function by clicking the Library icon (page 13).

 Link – a command used on a button to:

 redirect a Viewer Page to another Page when the button is pressed, for 
example, a Home page button, which redirects the display to the home 
page.

 redirect one or more Viewers to a specified Page when the button is 
pressed. For example, when an Exit button is pressed, you can have all 
Viewers (used by touch panels and/or mobile devices in one meeting 
room) return to their home page.

 Configure the following fields for the command:

 Link To: Select a destination page

 Myself/Mirror: Select Myself to have the Viewer link to a selected 
page only on the tapped device; select Mirror to have all the 
devices that use the same Viewer file to return to the selected page.

For more information on configuring a button, see Configuring Button/Slider 
Bar Actions, page 90.

 Set Variable – creates a variable to represent a device setting (e.g. 
speaker volume) that can be used by two or more control objects (e.g. 
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slider bar or buttons) in the Viewer. This function is used when you have 
more than one Viewer objects controlling the same device.

Note:To complete this setting, go to Properties of the control objects and 
configure the Set Sync Conditions setting.

 Save Variable – saves changes to a variable immediately after receiving a 
new value. The default mechanism is to save new values approximately 30 
minutes after receiving the changes. This is to prolong the life expectancy 
of flash memory of the controller.

 Set Flag – sets a flag value to represent the new device status when a 
command changes a device setting. Set Flags are added to the Commands 
list after device commands to change the Flag (device status).

 Condition – adds one or more conditions that must be met for subsequent 
command(s) to initiate. The conditions can be based on created Variables 
or feedback values that the controller receives from managed devices. 

 Use Variable If to add a condition by comparing a created variable to a 
value or another variable. For example, if you want a display a warning 
message on the Viewer when the volume of a speaker is at its 
maximum (10 dB), you will need to: 

(a) Set up a Variable for the speaker volume. 

(b) Select a Variable If condition. 

(c) Double-click the condition to set the Variable value to 10. 

(d) Drag a Change Label command and nest it under the condition 
you selected in step (a). 

(e) Double-click the Change Label command to type the warning 
message you wish to display when the speaker volume reaches 10 
db.

 Append a Variable Else If condition to a Variable If condition for 
binary conditions. To add this condition, drag-and-drop it from the 
Function column to a Variable If condition in the Commands 
column.

 Append a Variable Else condition to a to a Variable If and Variable 
Else If pair for scenarios with 3 conditions—to describe what action 
to take when the previous two conditions are false. To add this 
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condition, drag-and-drop it to the Variable If condition in the 
Commands column

 Use Multi-Variable If to add multiple conditions using created 
Variables. For example:

- Click  to add conditions. You can add up to 5 conditions

- Use the drop-down menu to select between and and or.

 Append a Multi-Variable Else If condition to a Multi-Variable If 
condition for binary conditions. To add this condition, drag-and-drop 
it from the Function column to a Multi-Variable If condition in the 
Commands column.

 Append a Multi-Variable Else condition to a Multi-Variable if and 
Multi-Variable Else If pair for scenarios with 3 conditions—to 
describe what action to take when the previous two conditions are 
false. To add this condition, drag-and-drop it to the Multi-Variable If 
condition in the Commands column.

 Feedback conditions – Use feedback conditions for the controller to 
carry out actions (commands) when the specified feedback value meets 
the specified conditions. Use Feedback If, Feedback Else If, and/or 
Feedback Else to fully cover all scenarios in your application.
Note: The Else If and Else conditions can only be nested under the If 
conditions and can not be used on their own.

 Change Button State – this command changes the image of another 
button when this button is pressed – allowing the image of any other button 
to change when the command from this button is sent. Change Button 
State is added to the end of the Commands lists. When adding this to a 
Toggle button it allows the image to switch with the toggle behavior: 
Normal or Pressed. In this situation the Change Button State is added to 
the end of both the Toggle ON and Toggle OFF Commands lists.

 Change Label – this option changes a label’s text with text that you enter 
manually or with text from a device’s return message. A Manual Change 
Label can be added to the beginning or end and with a Condition in the 
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Commands list. Adding it to a Condition guarantees the label only changes 
when the command initiates.

 Change Group Button State – this option adds a command that changes 
the button selected in a Radio Group (page 17). Create a Radio Group 
and then a Function will be listed for it when Change Group Button State is 
selected. Add the Change Group Button State to the Commands list of a 
button and use the drop-down menu to select the button in the Radio Group 
you want selected. 

 Change Slider Bar Level – this option adds a command that changes the 
level of a Slider Bar. Create a Slider Bar and then a Function will be listed 
for it when Change Slider Bar Level is selected. Add the Change Slider Bar 
Level to the Commands list of a button and use the drop-down menus to 
select the Slider Bar and Level to change.

 Change Button Name – this option adds a command that displays 
specified text on another button when this button is tapped. A typical 
application of this command is when you want to show the assigned source 
on an output device as soon as the source is switched.

 Function – lists the commands that can be added to the Commands 
list. Select an option under Device, then double-click or drag & drop 
commands from the Function list to add them to the Commands list. 

 Kill Cmd – cancels received but not-yet-executed commands when the 
button is pressed, toggled on, or long-pressed. 
Configure the following to define the targets of this kill-command action:
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1. Select the target Viewer from the Function drop-down menu. The 
available pages of the selected Viewer are listed.

2. Double-click any listed page to add a kill command. A kill command 
appears in the Commands column.

3. Double-click on the added command to define the targets. Available 
setup combinations include:

Myself Mirror

All Stop all pending actions on the 
Viewer device where the kill 
command action is initiated.

Stop pending actions on all Viewers 
stored on the specified controller.

Viewer Stop all pending actions on the 
Viewer device where the kill 
command is initiated, and also on 
other Viewer devices that use the 
same Viewer.

Object Stop pending actions for the 
specified control objects (elements) 
on the Viewer device where the 
kill command action is initiated.

Stop pending actions for the 
specified control objects (elements) 
on all the Viewer device where the 
kill command action is initiated, and 
also on other Viewer devices that 
use the same Viewer profile.
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Applications of Advanced Functions
Advanced Options allow you to include conditions with commands in the 
Commands list. Associate Set Flag, Condition, Change Button State or 
Change Label functions with a command in the Commands list by dragging and 
dropping them into a tree view listed with the command, so that they initiate in 
the order listed. 

Set Flag
Adds a Set Flag to change a Flag’s value when a command changes a device 
setting. This sets the Flag value to match the new device setting (e.g. ON or 
OFF). Always add a Set Flag to a Condition Flag, after the device action(s):

To add a Set Flag:

1. Under Device, select Set Flag.

2. From the Function list, select the Flag. 

3. From the Function list, drag and drop the Flag to add it to the end of the 
Condition Flag, in a tree view list:

4. Double-click Set Flag in the Commands list to use the drop-down menus to 
set the Flag and Value. 
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Condition
Adds a condition that must be met before the commands listed with it can 
initiate. When the button is pressed, the Condition's set value must equal the 
Flag or Feedback value for the command(s) to initiate. There are two condition 
types: Flag and Feedback.

 Flag – Adds a condition based on a Flag’s value. “If Flag equals Value” is 
true, the condition is met and the commands listed with the Condition will 
initiate. Always add a Condition Flag at the top of the Commands list, drag 
and drop the device command(s) and then a Set Flag at the end, in a tree 
view list:

To add a Condition Flag: 

1. Under Device, click Condition.

2. From the Function list, select Flag.

3. Double-click Flag to add the Condition Flag to the Commands list.

4. Double-click the Condition Flag in the Commands list to use the drop-
down menus to set the Flag and Value. 
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5. From the Function list, drag & drop device commands to add them to 
the Condition Flag, in a tree view list:

6. Add a Set Flag after the last device command in the Commands list:

 Feedback – adds a condition based on the text from a serial/telnet/SSH/
TCP device’s return message. Always add a Condition Feedback to a 
serial/telnet/SSH/TCP command, with command(s) added below the 
Condition Feedback, in a tree view list:

Receive Time – when a Feedback condition is added to a device 
command the wait to Receive Time drop-down menu appears allowing you 
to set the amount of time to wait before it stops receiving the return 
message from the device.

There are three Condition Feedback types:

 Equal – when the text sent from a serial/telnet/SSH/TCP device’s 
return message matches all of the text entered for a Condition 
Feedback Equals, the commands listed below it will initiate.
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 Include – when the text sent from a serial/telnet/SSH/TCP device’s 
return message matches part of the text entered for a Condition 
Feedback Include, the commands listed below it will initiate.

 Bypass – this option bypasses matching text from the serial/telnet/
SSH/TCP return message and initiates a Change Label command. The 
label’s text will change to the return message sent from the device (i.e. 
the Feedback Result). A Change Label must be added to the 
Feedback Bypass for it to work.

To add a Condition Feedback Equal/Include: 

1. Under Device, click Condition.

2. From the Function list, select Feedback.

3. From the Function list, drag and drop Feedback to add it to the serial/
telnet/SSH/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select equal to or include and enter the Text. 

Text entered here must match all (equal to) or part (include) of the text from 
a serial/telnet/SSH/TCP device’s return message for the command(s) to 
initiate. Use the ASCII / HEX drop-down menu to select the format. 



Chapter 2. ATEN Configurator

107

5. From the Function list, drag & drop device command(s) to add them to 
the Feedback Equal/Include Condition, in a tree view list:

To add a Feedback Bypass Condition with Change Label:

1. Under Device, click Condition.

2. Select Feedback from the Function list.

3. From the Function list, drag and drop Feedback to add it to the serial/
telnet/SSH/TCP command, in a tree view list:

4. Double-click If Feedback equals to in the Commands list and use the 
drop-down menu to select bypass.

5. Under Device, select Change Label.

6. From the Function list, select the Viewer Page where the label is 
located.
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7. From the Function list, drag and drop the Viewer Page to add it to the 
Feedback Bypass Condition, in a tree view list:

8. Double-click Change Label in the Commands list and use the drop-
down menu to select a label. Labels are identified by object IDs (see 
page 62).

The label’s text will change to the serial/telnet/SSH/TCP device’s return 
message. 
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Change Button State 
This option is used to change another buttons image when this button is 
pressed – allowing the button image to switch depending on the status: Normal 
or Pressed. Change Button State is added to the end of the Commands lists and 
should point to a Toggle button. Adding this to a Toggle button allows the 
image to switch with the toggle behavior: Normal or Pressed.

To add a Change Button State:

1. Under Properties, use the Mode drop-down menu to select a button type. 

2. Under Style, click the Normal and Pressed button to select an image/
color* for the button’s state. 

Note:Use the Style drop-down menu to select Image to import an image file 
for the button state, or Color to choose a color format for the button state.

3. Add the Toggle ON and Toggle OFF device commands to the Commands 
lists.

4. Under Device, select Change Button State.
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5. In the Function list, select the Viewer page.

6. Select the Toggle ON radio button, then in the Function list, double-click 
the Viewer page to add it to the end of the Toggle ON commands in the 
Commands list. 

7. Select the Toggle OFF radio button, then in the Function list, double-click 
the Viewer page to add it to the end of the Toggle OFF commands in the 
Commands list.

8. In each Commands list, double-click the Change Button State command 
to set the Button and State (Normal or Pressed). 
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Change Label
Changes a label’s text with text that you enter manually or with text from a serial/
telnet/SSH/TCP device’s return message (Feedback Result). A Change Label 
that uses a return message, must be added to a Feedback Bypass Condition 
(page 107). A Manual Change Label can be added anywhere in the 
Commands list. Adding it to a Condition guarantees the label changes only 
when the command initiates. 

To add a Manual Change Label:

1. Under Device, click Change Label.

2. In the Function list, select the Viewer page where the label is located.

3. Double-click or drag and drop the Viewer page to add the Change Label to 
the Commands list.

4. Add a Change Label to multiple or Toggle ON / Toggle OFF Command lists 
to have the same label change text for different actions. 

5. In the Commands list, double-click Change Label to use the drop-down 
menu to select a Label and input the Text. This is the text in the label that 
will appear when the button is pushed. 

Repeat the steps to add a Change Label for the reverse action (i.g., On and 
Off). 
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Change Group Button State
Adds a command that changes the selection in a Radio Group (see page 17). 
To use this function, first create a Radio Group and then add a button to the 
Viewer page. Add a Change Group Button State independently or with a 
device command:

To add a Change Group Button State:

1. Under Device, select Change Group Button State.

2. From the Function list, select the Viewer Page where the Radio Group is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Group Button in the Commands list and use the 
drop-down menu to select the Button. 
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Change Slider Bar Level
Adds a command that changes the level of a Slider Bar. To use this function, 
first create a Slider Bar on a Viewer page. Add a Change Slider Bar Level 
independently or with a device command.

To add a Change Slider Bar Level:

1. Under Device, select Change Slider Bar Level.

2. From the Function list, select the Viewer Page where the Slider Bar is 
located. 

3. From the Function list, drag and drop the Viewer Page to add it to the 
Commands list:

4. Double-click Change Slider Bar in the Commands list and use the drop-
down menus to select the Slider Bar and Level. 
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Change Button Name
The Change Button Name command is used to display specified text on a 
selected button when the configured button is tapped. An application of this 
command is indicating the assigned source for a display device on a Viewer as 
soon as the source is assigned. This way, you can keep track of the source that 
is currently showing on a particular display device. 

Example: 

 Indicate the currently assigned source on a display device (in the Viewer).

 Assume an environment consisting of one monitor and five sources buttons 
(computer, laptop, camera...etc.), as illustrated below, and that when a 
source button is tapped, the source will be immediately assigned to the 
display. 

Configuration goal: To have the assigned source printing on the display button 
(on the Viewer page), configure each source button so that when it is tapped, 
the following actions (commands) initiate: (1) Display the source to the display; 
(2) Print the name of the assigned source onto the display device. 

1

2

4 5
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1. Click a source button to display the Button Action panel.

2. In the Button Action panel, select Change Button Name.

3. From the Function list, double-click the Viewer page where the source 
button is located. In this example, double-click the Video Wall option. The 
Change Button Name command is added.

4. From the Commands list, double-click the Change Button Name command 
and configure the following.

 Select the ID of the display button to indicate the location of print the 
text. In this example, it is the video wall’s ID. 

 Type the text you wish to show when the source button is tapped. In this 
example, enter “PC”.

5. Follow steps 1 to 4 to configure each of the source buttons.
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Design Library

The Library icon on the Project bar offers the following functions. The table 
below provides an overview of each function.

Control Description

Graphic 
Library

Find graphic templates such as backgrounds, buttons, device 
icons, and control interfaces for your viewer. For details, see 
Graphic Library, page 117.

Flag Flags are created to include parameters when settings are 
changed to indicate the current status. For details, see Flag, 
page 120.

Monitor Monitors allow you to set Conditions for Digital Input (dry contact) 
and Digital Input (VDC) signals and Flags on a port that will initiate 
an Action. In addition, you can create Listen to port and Query 
port monitors which check a device’s status to initiate actions. For 
details, see Monitor, page 122.

Macro Macros initiate a sequence of actions on one or more hardware 
devices. For details, see Macro, page 144.

Schedule Click to create scheduled events. For details, see Scheduled 
Events, page 146.
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Graphic Library
The Library icon on the Project bar provides a Graphics tab and drop-
down menus with ready-to-use graphics for backgrounds, buttons, 

icons and device interfaces. Device Interface provides entire page layouts that 
you can use as templates for different types of devices. Double-click or drag and 
drop graphics to add them to the page. Images can be imported for icons and 
buttons in various formats (*.png,*.jpg,*.jpeg,*.bmp). 

Button

Variables Creates a Variable for a device setting (e.g. volume) that is 
controlled by two or more objects (e.g. slider bar or buttons) on 
the Viewer. When the device setting is changed through one of 
the objects, its setting is automatically synced and reflected on all 
the objects. For details, see Variables, page 148.

Timer A timer event is a device action that initiates as soon as the 
defined countdown time is up. The advantage of using a timer 
event, as opposed to a combination of delay command and 
device command, is that it saves time by executing the defined 
action while other actions (commands) within the series execute. 
For more details, see Timers, page 157.

Control Description
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Background

Image (Device Icon)
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Device Interface
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Flag
Flags are created for control buttons to include parameters for when 
settings are changed or requests are made to change settings on a 

device. Flags indicate what the status is and what action to take according to 
the value. Flags are added as actions to Button Properties as a Condition or 
Set Flag value. 

Conditions tell a button to initiate associated actions if the flag value is true: “If 
Flag equals Value” initiate the action. Actions are associated with a condition 
so that they only initiate if the flag value is correct. That way an ON command 
is only sent to a device if the current flag value is OFF. 

Set Flag changes the flag value when a device setting has changed. So that if 
a device is OFF and the action turns the device ON, adding a “Set Flag 1 to ON” 
will change the flag value to ON. Now the flag’s value matches the device status 
so that actions associated with flag Conditions will initiate accordingly. 

Create flags for a device and add them as a Condition and Set Flag value in the 
Action – Button Properties (see Button / Slider Bar / Dial Kit Actions, page 87). 

To create a Flag:

1. Select Flag and click . The New Flag menu appears.

2. Enter a Name and select a radio button to set the flag value.

 Select On/Off and use the drop-down menu to select the Default Value. 

 Enter a range (1-100) for the values in the two boxes and use the drop-
down menu to select the Default Value. Use the drop-down menu to 
select the format ASCII or HEX. 
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3. Click  to create more flags or double-click a flag to edit it. The 
flags will appear in the list, as shown below.

 Name – Lists the Flag names which have been created. 

 Value – Lists the flag’s values or range of values. 

 Default – Lists the flag’s default value.

 x – Deletes a flag from the list. 

4. Select Condition or Set Flag to add flags as a command in Button Action 
by selecting a button on a Viewer page (see Button / Slider Bar / Dial Kit 
Actions, page 87). 
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Monitor

Understanding Monitor
A Monitor allows you to set conditions on a port using Digital Input (VDC) and 
Digital Input (Dry Contact) signals, return messages, and Flags. When the 
condition is met, the controller will initiate the desired action. Digital Input (VDC) 
hardware devices provide voltage signals between 1 and 24. Digital Input (Dry 
Contact) hardware devices provide open and closed circuit signals. Hardware 
devices with return messages can be monitored using Listen to port or Query 
port conditions via text they transmit. These signals provide indicators from 
sensors or switches of an event. An event can be the temperature, power, dry 
contact, sensor, switch status, or message from a device. There are two parts 
to a monitor, the Condition and Action.

Monitor Page Options
There different types of monitors you can create to fulfill different scenarios. A 
monitor (as illustrated below) contain the following configuration fields:
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Control Description

Type Use this drop-down list to select a monitor type:

 If – select this option for a single condition monitor. “If” the 
single condition is met, the action initiates. For details, see 
Creating an If Monitor, page 127.

 Switch – select this option for multiple conditions that use more 
than one “If” conditions for the monitor. In this type, if one of the 
conditions is met, the monitor will initiate the action. For details, 
see Creating a Switch Monitor, page 131.

 Bypass – select this option to transmit device feedback 
message to the selected variable actively listening for a 
message or by receiving a return message from the specified 
devices. For details, see Creating a Bypass Monitor, page 135.

 While Loop – select this option to execute the specified actions 
at the defined frequency (Query Frequency). For details, see 
Creating a While Loop Monitor, page 137.

 Professional – select this option to create variables and load 
values into these variables using programming script. For 
details, see Creating a Professional Monitor, page 138.

Name Enter a name for the monitor. 

Query Frequency Use this drop-down menu to select how frequently the monitor 
checks a device for a signal. 

Condition Use this section to add one or more conditions that will need to be 
met for the Action to initiate. You can create up to 32 conditions for 
each monitor. For details, see Condition Types, page 124.

Action Use this section to create the commands that will initiate when the 
monitor’s conditions are met. For details, see Device Functions, 
page 93 and Advanced Functions, page 97.

Click to hide or display the Device and Status/Function columns in 
the Condition and Action lists so that you can see a complete row of 
Conditions/Commands.

Click to move an selected command up or down in the Commands 
list.

Click to remove an selected command from the Commands list. 
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Condition Types
Note that you can create up to 32 conditions for each monitor.

 Listen to port / Query port
 (Query port only) Click F(x) to open the drop-down menu to select a 

device command to send out; or enter a command string; and then the 
click Edit Return Message icon and do as explained below.

 Edit Return Message
(Listen to port / Query port) Next configure the parameters for the return 
message from the device. This message must match for the condition 
to be met. In the Condition list double-click the command and then 

click  to open the Edit Return Message window:

Use the drop-down menu and enter a string of that will represent the 
characters in a return message from the serial device:
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 Select string with fixed length

Use this to set a string of characters that are set within a fixed 
parameter. Enter a string of characters and use the S to set the start 
of the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see next page) for the monitor to 
be triggered.

 Select string with a non-fixed length 

Use this to set a string of characters where the parameters are 
variable. Enter a string of characters and use the S to set the start of 
the string and E to set the end and then click Apply. The return 
message will need to fit the fixed string of characters set in the text 
box next to the Drop-Down Menu (see below) for the monitor to be 
triggered.

 Drop-Down Menu

Above, enter characters that the Select string with fixed length or 
Select string with non-fixed length string must match and how they 
must be matched: Equal to, Not equal to, Include, or Exclude for 
the condition to be triggered. 

 Flag 
Creates a flag condition for the monitor. Use the drop-down menus to set a 
format (how the flag value must be matched) and the flag value for the 
condition to be triggered. 
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 I/O Input
Create a trigger signal from a device according to the voltage. Only device 
with a Digital Input (dry contract) or Digital Input (VDC) port appear in the 
Status list. Double-click a device in the Status list to add it to the Condition 
list. Double-click the command in the Condition list to configure the setting:

The High or Low status tells the Monitor to initiate an Action when the 
device signal is above or below the threshold setting* for the port:

Digital Input (VDC)

 High - states that when the voltage signal is above the Upper 
Threshold to initiate the Action.

 Low - states that when the voltage signal is below the Lower 
Threshold to initiate the Action.

Digital Input (Dry Contact)

According to an open or closed circuit status for the port: 

 Open - states that when the circuit is Open to initiate the Action.

 Closed - states that when the circuit is Closed to initiate the Action. 

Functions
 Delay – adds a delay in seconds. Enter a number between 0.1-180. 

 Relay – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Relay port. 

 DO – adds an Open, Close, Toggle or Pulse action on the selected 
controller and Digital Output port. 

 Wake on LAN – powers on the specified computer (MAC address) over 
Ethernet.

 Serial Raw (ASCII) – adds a serial command in the ASCII mode.

 Serial Raw (HEX) – adds a serial command in the HEX mode. 

 Telnet Raw (ASCII) – adds a telnet command in the ASCII mode.

 TCP Raw (ASCII) – adds a TCP command in the ASCII mode. 

 TCP Raw (HEX) – adds a TCP command in the HEX mode. 

 UDP Raw (ASCII) – adds a UDP command in the ASCII mode.
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 UDP Raw (HEX) – adds a UDP command in the HEX mode.

 HTTP – adds an HTTP command.

 HTTPS – adds an HTTPS command.

 TCP Feedback Raw (ASCII) – adds a feedback in ASCII format to having 
received a monitored input from a TCP client device.

 TCP Feedback Raw (HEX) – adds a feedback in HEX format to having 
received a monitored input from a TCP client device.

 Pronto Hex Code – adds an IR command using Pronto Hex codes.

 KNX Raw – adds a KNX raw command. Note that this type of commands 
can only be used on a custom KNX device. For details about adding a KNX 
device to ATEN Control System, see Adding KNX Devices, page 28.

 SSH Raw – adds an SSH command in the ASCII mode.

Creating an If Monitor
To create a monitor for a device port with a Condition that initiates an Action,  
do the following.

1. In the Design tab, click Library  and click Monitor .

2. Select a controller to which you want to create the monitor.

3. Click 

4. Select If from the drop-down menu and enter a name for the monitor. 

5. Use the drop-down menu to set the Query Frequency.
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6. Select All Conditions or Any Conditions.

These options are only for advanced setups that require multiple events 
from hardware devices connected to multiple conditions. Most devices only 
require one signal Status added to the Condition List to initiate an Action. 
Most installations will not need to use this option, therefore it can be 
ignored. 

 All Conditions: Add multiple conditions – all of which must be met for 
the Action to initiate. 

 Any Conditions: Add multiple conditions – one of which must be met 
for the Action to initiate. 

7. Under Device, select a Controller from the drop-down menu, and then 
choose one of the following monitor types. For details, see Condition 
Types, page 124.

 Listen to port – to create a monitor that actively listens for a message 
from the device. Under Status, double-click a device port to add it to the 
Condition list.

 Query port – to create a monitor that sends out a command to the 
device until a feedback message is received from the device. 

 Flag – to create a flag condition for the monitor. 
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 I/O Input – to create a trigger signal from a device according to the 
voltage. 

8. Under Status, double-click to add a device port or flag to the Condition list. 
Then double-click the device port or flag in the Condition list to configure 
the condition settings.

Note:To set the controller as a TCP server, use the TCP Server option in 
the Status column, and make sure to type a TCP server port in the 
controller’s properties settings (page 29).

9. (Optional) Use the Operator option to add additional High or Low conditions 
(see step 4, page 128). 

10. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.

Note: For more information about Functions, see Button / Slider Bar / Dial 
Kit Actions, page 87.

a) First select the hardware under Devices. 
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b) Under Function, double-click a command to add it to the Commands 
list. This Command initiates when the Condition is met. For details on 
Functions and Commands, see Device Functions, page 93 and 
Advanced Functions, page 97.

Note:If you have configured the controller as a TCP server, add TCP 
Feedback Raw (ASCII) or TCP Feedback Raw (HEX) command to provide 
feedback to the TCP client.
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Creating a Switch Monitor

1. In the Design tab, click Library  and click Monitor .

2. Select a controller to which you want to create the monitor.

3. Click 

4. Select Switch from the drop-down menu and enter a name for the monitor. 

5. Use the drop-down menu to set the Query Frequency.

6. Use the options to create multiple condition comparisons, as explained 
below.
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7. Go to the Action section at the bottom of the page to select the hardware 
Device and add the Function to the Commands list, as explain in the 
steps that follow.

Control Description

Type Use the drop-down menu to select:
If – select this option for a single condition comparison monitor. 
Switch – select this option for multi-condition comparisons that 
use multiple “If” comparisons for the command. 

Name Enter a unique name for the monitor. 

Query Frequency Use this drop-down menu to select how frequently the monitor 
checks a device for a signal. Options are: 100 ms - 1 second. 

Drop-Down Menus Under the Type drop-down menu are four addition drop-down 
menus used to configure the Switch Condition: 
 Controller – use the first drop-down to menu select the control-

ler for a Switch condition. 
 Listen to port / Query port – use the second drop-down menu 

to select the condition type for a Switch condition (see step 4, 
page 128 for details).
 Serial Device Port 
 Use the third drop-down menu to select a serial device 

port and configure Edit Return Message (to configure, see 
Edit Return Message, page 124).

 To set the controller as a TCP server, use the TCP Server 
option in the Status column, and make sure to type a TCP 
server port in the controller’s properties settings 
(page 29).

 Case – use the fourth drop-down menu to add cases by select-
ing Add More Cases for comparison that need to be met before 
monitor’s condition will initiate. In the left text box enter a name 
for the Case, in the right text box enter the character string that 
the return message should match. 

Action Use this section to create commands for the monitor. See Button / 
Slider Bar / Dial Kit Actions, page 87, for details on configuring 
commands.

Click this icon to switch to the Action list view so that you can see 
a complete row of the command’s functions. This is a toggle 
button. 

x Closes the Monitor window. 
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Note: For more information about Functions, see Button / Slider Bar / Dial 
Kit Actions, page 87.

8. First select the hardware under Devices. 

9. Under Function, double-click a command to add it to the Commands list. 
This is the Command that initiates when the Condition is met. For details 
on what each function does, see Device Functions, page 93 and Advanced 
Functions, page 97.
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Note:If you have configured the controller as a TCP server, add TCP 
Feedback Raw (ASCII) or TCP Feedback Raw (HEX) command to provide 
feedback to the TCP client.

10. You can also add a Macro, Link, Set Flag or Monitor’s Condition.

11. After adding all the functions to the Commands list, the Switch monitor is 
complete. 
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Creating a Bypass Monitor
Follow the steps below to create a bypass monitor.

1. In the Design tab, click Library  and click Monitor .

2. Select a controller to which you want to create the monitor.

3. Click 

4. Select Bypass from the drop-down menu and enter a name for the monitor. 

5. Configure the following settings. 

 Query frequency: sets how frequently the monitor checks the device 
for a signal. Valid values range from 100 ms to 1 second.

 In the second drop-down list, select one of the following:

 Listen to port: actively listens for a message from the specified 
device. 
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 Query port: when a setting is changed on the specified device, the 
device sends a feedback message to the controller, informing the 
latest setting.

 In the last drop-down list, select the port or the device to be monitored.

6. Configure the actions.

a) Select Set Variable.

b) Double-click the variable you wish to update when controller detects a 
change for the specified device setting.

c) For a variable, double-click the command and select Bypass.
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Creating a While Loop Monitor
Follow the steps below to create a while loop monitor.

1. In the Design tab, click Library  and click Monitor .

2. Select a controller to which you want to create the monitor.

3. Click 

4. Select While Loop from the drop-down menu and enter a name for the 
monitor.

5. Use the Query Frequency drop-down menu to define the frequency at 
which the device checks for signals.

6. From the Device List, select a device. 

7. (Optional) Select an advanced option. For details, see Advanced 
Functions, page 97.
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8. Double-click a function to added it to the Commands list. For 
details, see Device Functions, page 93 and Advanced Functions, page 97.

9. Configure the added commands if required.

Creating a Professional Monitor
Example: Keep track of the assigned sources by indicating the input port 
number of the assigned source on each of the four screens on a Viewer page, 
as illustrated below.

For the controller to print the port number of the assigned source on each 
screen and keep this information up-to-date, the controller needs to:

 constantly keep track of the assigned source

 constantly print the port number on each screen icon
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Follow the steps below to create a professional monitor.

1. In the Design tab, click Library  and click Monitor .

2. Click  to create a new monitor.

3. Configure the following settings.

 From the Type drop-down menu, select Professional.
 Name the monitor.

 Define the query frequency.

4. Configure the condition settings.
In this example, the controller VK2100 is set to query the input and output 
ports of the Matrix Switch, VM6404H, that connects to the controller every 
0.1 second.

 Add the condition(s) that must be met for initiating actions. For details 
on conditions, see Condition Types, page 124. 

 Select a Trigger Mode for the added conditions.



Chapter 2. ATEN Configurator

140

 And: Only initiate the added actions (commands) if the values of all 
specified inputs change.

 Or: Initiate the added actions (commands) if the value of any 
specified input changes.

 Independent: Use this option when you have multiple sets of 
actions. The added actions (commands) initiate if the corresponding 
set of inputs change in value.

 Always: Initiate the added actions (commands) at the specified 
frequency.

5. Configure the Action settings.

a) Click Edit to script the codes. 

Note:
 This editor follows Lua’s programming rules. ATEN suggests using 

Notepad++ to script the codes before adding them to the Editor.

 For details on built-in commands, see Built-in Commands, page 141.

 When scripting codes for I/O inputs, use lower case “l” to represent the 
close status (e.g. input_io == ‘l’), and “h” to represent open status (e.g. 
input_io == ‘h’).

In this example, use Script Editor to:

 Convert data format.

 Create four variables representing the assigned input for each screen. 
In this example, InputNToOutput1, InputNToOutput2, InputNToOutput3, 
and InputNToOutput4 are created.

 Load the input number of the assigned source to the created variables.
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Below is sample of the scripts used for this scenario:

b) Add actions. 
In this example, add four Change Button Name commands:

For details, see Device Functions, page 93 and Advanced Functions, 
page 97.

Built-in Commands

function vk_parser(input)
dglocal vminput = vk_hex_toascii(input)
dg-- local vminput = input
dgif vminput == nil or vminput == ’’’’ then
dgsdfsdfdf s return
fgend

d local map = {}
fgfor vmout, vmin in string.gmatch(vminput, “o([0-9]*)i([0-9]*) video [^ ]* audio [^ ] * [^\n]*”) do
fgsfdsfdfsfdsmap[vmout] = vmin
fgend

dglocal vk_var_1_InputNToOutput1 = map[”01”]
f glocal vk_var_2_InputNToOutput2 = map[”02”]
dglocal vk_var_3_InputNToOutput3 = map[”03”]
dglocal vk_var_4_InputNToOutput4 = map[”04”]

dgvk_docommands_1_VMRead(vk_var_1_InputNToOutput1, vk_var_2_InputNToOutput2, vk_var_3_InputNToOutput3, vk_var_4_InputNToOutput4)
end

Command Description

jsonobj Converts JSON strings to tables.

vk_ascii_to_hex Converts strings from ASCII to Hex.

vk_docommands_ID_name Defines the commands to be executed, e.g., 
vk_docommands_1_output. A 

the user should define his/her own commands and their 
corresponding IDs. As long as the ID does not change, 
the command name can change.

The same ID cannot be used for two different 
commands. The same applies to command names.

vk_hex_to_ascii Converts strings from Hex to ASCII.
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vk_parser(input1, input2)  Use this command to indicate a start to a set of 
scripts. 

 The brackets should contain equal number of inputs 
that you added in the Professional Monitor setup. 

 If the Trigger Mode is set to independent, the script 
should contain only one input, but the number of 
parsers should match the number of inputs added 
to the Monitor, e.g. vk_parser_1(input), 
vk_parser_2(input).

vk_var_ID_name Create a variable.

Command Description
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Duplicating a Created Monitor
To duplicate a created monitor to another controller, right-click a monitor, mouse 
over Duplicate, and then select a target controller.
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Macro
Macros allow you to create a button that will initiate a sequence of 
actions across the same or different hardware devices. This saves time 

by allowing multiple devices to initiate actions all at once from one button. For 
example, you can create a macro to start a video presentation by adding 
functions to: dim lights, power on source, power on display, lower screen and 
play source. You can also add time delays between actions in a macro. Each 
project can store up to 104 macros.

When you click  from the Library’s Macro tab, the window opens: 
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To create a macro:

1. Select Macro and click . 

2. Enter a Name and select a Viewer from the drop-down menu, then click 
OK. 

3. Go to the Actions section at the bottom of the page to select hardware 
under Device and add the Function to the Commands list:

Note: For more information about adding Functions, see Button / Slider Bar 
/ Dial Kit Actions, page 87.

4. After adding all the functions to the Commands list, the macro is complete.

5. In Create Viewer & Design, create a button and add a macro to the Button 
Action properties (see page 87) by selecting Macro under Devices (see 
Device Functions, page 93 for details).
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Scheduled Events
You can have one or a series of tasks execute recurringly on specified 

time of the day. Each project can store up to 60 scheduled events. Note that this 
feature is not applicable to Control Pads.

Creating a Scheduled Event

1. In the Design tab, click Library  and click Schedule .

2. Select a controller to which you wish to create an event.

3. Click . A new event window appears.

4. Name the event.

5. Click to specify a recurring schedule for the event.

6. Configure event actions.

a) In the Device column, select a device.

b) In the Function column, double-click the desired functions. The 
corresponding commands appear in the Commands column. For details 
on what each function does, see Device Functions, page 93.

c) In the Commands column, double-click each command to configure the 
settings.

7. Optionally add system functions. For detailed information, see Applications 
of Advanced Functions, page 103.

8. These commands will initiate in the listed order. To change the order of the 

commands, click .
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Duplicating a Scheduled Event
To duplicate a created event to another controller, right-click an event from the 
event list, mouse over Duplicate, and then select a target controller.
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Variables

Understanding Variables
A Variable is a value holder that stores a single device setting (e.g. speaker 
volume) and can be assigned to multiple control objects (e.g. a slider button, a 
maximum volume button, and a minimum volume button). This way, when a 
device setting is adjusted via a Viewer object, the new setting will be loaded into 
this Variable and then reflected to all Viewer objects that use this Variable. Each 
project can store up to 128 Variables.

Below is a Variable list that has two variables created, temperature and speaker 
volume, for devices controlled by VK1200-ID02.

This feature is useful for automatic synchronization of device settings, 
especially when you have two or more objects in a Viewer controlling a single 
device setting. Take the example of controlling a speaker volume on a Viewer. 
On your Viewer, you may have a slider bar which you use to adjust the volume, 
a button that sets the speaker to its maximum volume, and another button for 
minimum volume. When you tap the maximum volume button, you would like 
the following status changes reflected on the Viewer:

 The maximum volume button shows a toggle-on status

 The minimum volume button synchronized with this setting and shows a 
toggle-off status

 The slider bar synchronizes with this setting and moves to its highest 
volume
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Creating a Variable for Devices that Return Feedback Messages
Follow the steps below to configure a Variable if the Variable (device setting) is 
for a device that returns feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) In the pop-up window, click the Variable  icon.

c) Using the indicated drop-down list, select the controller which controls 
the target device. The variables created for the devices managed by the 
selected controller are listed.

d) Click . A Variable setup page appears.

e) In the setup page, configure the following settings.

 Name: Type a name for the Variable.

 String format: Select the string format for the target device.

 Setting range: Type two numbers to define the range for the variable. 
Valid numbers include negative numbers and numbers that contain one 
decimal place.
Note: If one of the numbers contains a decimal place (e.g. -5.0), make 
sure to specify the other number in the same format (e.g. 10.0). 

 Unicode: (Only available for string variables) Select this setting for 
multilingual text to be encoded and represented correctly in the 
variable.

 Default value: Type a default for the setting.

 Description: Optionally add additional information for the variable.
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Your settings may look like this:

2. Configure control objects for the Viewer. For details, see Configuring the 
Control Interface (Viewer), page 43.

a) In the Design tab, add control objects to your Viewer. 

Note: The Variable function is only applicable to toggle buttons, basic-
mode slider bars, and radio groups of normal buttons. Configure the 
Mode setting before you proceed.

b) For a slider bar object, click it in the Viewer page and configure the 
Value settings in Properties.

c) In Properties, click Set Sync Condition and select the variable you 
created using the drop-down list.

3. Create a Monitor to set up the conditions for which the device sends its 
latest setting to the variable. For detailed steps, see Creating a Bypass 
Monitor, page 135.
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Creating a Variable for Devices that Do Not Return Feedback 
Messages
Follow the steps below to configure a Variable if the Variable (device setting) is 
for a device that does not return feedback messages to the controller.

1. Create a Variable for the device setting (e.g. speaker volume).

a) In the Design tab, click Library.

b) Click the Variable  icon. 
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c) Using the indicated drop-down list, select the controller which controls 
the target device. The variables created for the devices managed by the 
selected controller are listed.

d) Click . A Variable setup page appears.

e) In the Setup page, configure the following settings.

 Name: Type a name for the Variable.

 String format: Select the string format for the target device.

 Setting range: Type two numbers to define the range for the variable. 
Valid numbers include negative numbers and numbers that contain one 
decimal place.
Note: If one of the numbers contains a decimal place (e.g. -5.0), make 
sure to specify the other number in the same format (e.g. 10.0). 

 Unicode: (Only available for string variables) Select this setting for 
multilingual text to be encoded and represented correctly in the 
variable.
Note: This feature is only effective if the target controller uses firmware 
v3.6 or later.

 Default value: Type a default for the setting.

 Description: Optionally add additional information for the variable.

 Select a command execution type.

 Execute commands with no conditions: Execute the command 
(action) when the value of the specified Variable changes.

 Execute commands with the specified conditions: Execute the 
corresponding command (action) when the value of the Variable 
matches. 

2. Configure control objects for the Viewer. 
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a) Add a control object to the Viewer. For details, see Configuring the 
Control Interface (Viewer), page 43.
Note: Make sure to configure the mode setting before proceeding to the 
next step.

b) For a slider bar, click it and configure value settings in Properties.

c) Click Set Variable, and then double-click the Variable you created in 
step 1.

d) In Properties, click Set Sync Condition and select the Variable you 
created using the drop-down list.

3. Repeat steps (a) to (d) with each of the objects. If you select Execute 
commands with the specified conditions, follow the steps below to add 
commands.

a) Refer to step 4 to first configure the control objects.

b) Click Library, click the Variable  icon, and then click the Variable you 
created in step 1.

c) Click the drop-down list below the Execute commands with the specified 
conditions option and select a condition.
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d) Add an action (command) when this condition is met. Select a device, 
double-click a desired function, and then double-click the command to 
configure the setting. 
In the case of speaker volume, when the volume changes to 0 (i.e. the 
condition is Variable = 0), the action will be “to change the speaker 
volume to 0”, as illustrated below.

e) Repeat steps 2(c) and 2(d) to add one or more actions to each condition.

4. If you select Execute commands with no conditions, follow the steps 
below to add commands.

a) In the Device list, click to select the device. In this example, the mixer, 
840T-1(Serial), is selected.

b) Double-click the action (command) and change the value type to 
Variable Value.
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Creating a Button for Bypassing Feedback to a Variable
Instead of creating a monitor event which automatically monitors the specified 
parameter at a defined interval, you can save the controller bandwidth by 
creating a button which performs the monitoring and saves the feedback to a 
variable only when pressed. 

1. Create a variable for storing the received feedback. Select STRING for the 
variable. Configure other settings as required. 

a) In the Design tab, click Library.

b) Click the Variable  icon. 

c) Using the indicated drop-down list, select the controller which controls 
the target device. The variables created for the devices managed by the 
selected controller are listed.

d) Click . A Variable setup page appears.

e) In the Setup page, configure the following settings.

 Name: Type a name for the Variable.

 String format: Select STRING.

 Unicode: (Only available for string variables) Select this setting for 
multilingual text to be encoded and represented correctly in the 
variable.
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 Default value: Type a default for the setting.

 Description: Optionally add additional information for the variable.

 Select a command execution type.

 Execute commands with no conditions: Execute the command 
(action) when the value of the specified Variable changes.

 Execute commands with the specified conditions: Execute the 
corresponding command (action) when the Variable matches

2. In a Viewer page, create a button object. 

3. Configure its button actions.

a) Add a command for receiving feedback.

b) Select Condition and then drag-and-drop a Feedback If command 
under your feedback command.

c) Set the feedback to bypass.

4. Add a variable command. Select a variable to store the feedback and then 
select Bypass.
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Timers
A timer event is used to initiate a device action as soon as the defined 
countdown time is up. It allows actions to be executed at defined times without 
waiting for previous actions to complete, unlike delay and device commands.

On top of initiating a specified action, you can also create additional controls on 
the Viewer to manually restart or stop the timer. For example, for a start meeting 
button, you would like to initiate the following series of actions when the button 
is pressed:

Among these actions, action #2 (switching source on a projector) can be 
designed as a timer event because:

 it needs a countdown (of 8 seconds) before the action can be initiated

 the remaining actions can be initiated without action #2 being completed

Sequence 
of Action Target Device Device Action Requirements

1

projector

Turn on the projector It takes 8 seconds for the 
projector to turn on and get 
ready.

2 Set the projector to 
switch to its HDMI source

This action can only be 
initiated when the projector 
is turned on.

2 ATEN Matrix 
Switch

Display input 1 to display 
1 via ATEN Matrix Switch 
(VM5808H)

This action is independent of 
the previous one, and can be 
initiated at the same time.

3 projector screen Bring down the projector 
screen

-

4 air conditioner Turn on air conditioner -

5 lighting system Turn on the lights -
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The configuration for the start meeting button is as follows, with the projector 
source switching configured as a timer event:

Configuring a Timer Event
1. Create a timer event in the Library.

a) In Configurator, go to 3. Design > Library , and then click Timer 

 in the pop-up window. This screen appears.

b) Select a controller to which you wish to create the timer event to.

c) Click . The Timer window appears.

d) Add a device action (command). For more details about commands 
(device actions), see Configuring Button/Slider Bar Actions, page 90.
For example, for a projector to switch its input source to HDMI, click the 
device in the Device column and then double-click the input source 
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command from the Function column. Double-click the added command 
to select HDMI for the Input Source.

To see only the added actions (commands) in this view, click .

e) Rename the timer event and configure the countdown duration.

2. Apply the timer to a control element (e.g. a button or a slider bar).

a) Click the target control element.
Example: a meeting start button
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b) In Action settings, click the target device (for the timer event), click 
Timer, and then double-click a function to add a timer event.

c) To configure the timer, double-click the added timer in the Commands 
column and select from the drop-down menus.

The following settings are available:

 controller: 

 timer: to change the current timer to another that is already created 
in the Library.

 timer type: you can change the action from starting a specified 
action to stop or restart.

 countdown duration
The timer action starts counting down as soon as the associated control is 
triggered, and the action initiates when the countdown time is up.

3. (Optional) Create another control (e.g. a button) for stopping or restarting 
the timer.

a) Add the control element to the Viewer page.
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b) Click the control element, and add the timer event you created in step 1, 
and double-click the command to select Restart or Stop from the drop-
down list.
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Duplicating a Created Timer
To duplicate a created timer to another controller, right-click a timer, mouse over 
Duplicate, and then select a target controller.
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Centralized Monitoring and Control via Unizon™

Overview

Unizon™
Unizon™ is a server-based software for centralized monitoring and control of 
standalone ATEN Video Matrix and ATEN-controller-managed AV devices, 
including ATEN and third-party devices. One ATEN control system allows 
management from up to two Unizon™ servers. Note that a license is required 
for using Unizon™. For more information, see ATEN Unizon™ User Manual.

Monitor ATEN-controller-managed Devices via Unizon™
When an ATEN-controller-managed AV device is added to Unizon™, the 
following information is available in the Unizon™ platform:

 connection status with Unizon™

 current IP address

 firmware version

 license usage (only applicable to ATEN controllers)

You can also create parameters to be monitored via Unizon™. For example, 
you may want to monitor the total hours used on a projector lamp so that you 
can arrange for replacement in advance when the accumulated lamp hour 
reaches a specified number. For setup details, see Creating a Monitor Item, 
page 165.

Control ATEN-controller-managed Devices via Unizon™
You can remotely operate ATEN-controller-managed devices via Unizon™, 
such as switching video sources on displays, changing the resolution setting, 
etc., by creating control items in the controller project file. For setup details, see 
Creating a Control Item, page 168.
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Enabling Monitoring and Control via Unizon™
Follow the steps below to enable monitoring and control of controller-managed 
devices via Unizon™.

1. In Configurator, select devices to allow management via Unizon™.

a) Open the target project and go to the Device tab.

b) In the Unizon column, select devices for remote management via 
Unizon™. For example:

2. (Optional) Create parameters for monitoring and/or control. For detailed 
steps, see: 

 Creating a Monitor Item, page 165

 Creating a Control Item, page 168

3. Upload the project to the controller.

4. On Unizon™’s web interface, add the controller. For details, see ATEN 
Unizon™ User Manual.



Chapter 2. ATEN Configurator

165

Creating a Monitor Item
1. Open the project file, go to Design > Unizon, and click on the device 

category of the target device to open the configuration page.
Example: To add a monitor item to a third-party projector, click Projector.

2. In the configuration page, click  and then select 
Add Monitor Item in a pop-up dialog box. A new monitor item is added.

3. Double-click the header Monitor Item to rename the parameter.
Example: Rename it to Lamp Hour.

4. Create a variable to store the value of the parameter and optionally 
configure alert settings.
Example: Create a variable to store the accumulated lamp hour and set up 
an alert at a specific number.

a) Under the monitor item you just created, click Sync Variable. The 
Properties panel appears on the right.
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b) In the Properties panel, click Set Sync Condition. The Edit Sync 
Condition dialog box appears.

c) In the General tab, click the first drop-down menu and select Create 
Variable to create a variable. For details about creating variables, see 
Variables, page 148.

d) In the General tab, select the variable you just created and configure 
related settings. For example:
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e) Optionally set up alerts for this monitor item. For example: 



Chapter 2. ATEN Configurator

168

Creating a Control Item
1. Open the project file, go to Design > Unizon, and click on the device 

category of the target device to open the configuration page.
Example: To add a control item to a Video Matrix, click Video Matrix 
Switch.

2. In the configuration page, click  and then select 
Add Control Item in a pop-up dialog box. A new control item is added.

3. Double-click the header Control Item to rename the parameter.
Example: Rename it to Output 1.
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4. Add and configure control options to this item.
Example: Create input 1 to 4 as options for switch the source on output 1.

a) Click .

b) In the pop-up dialog box, type the name of the control option and click 
Create. Proceed to create all the control options as required.

Example: Type Input 1 and click Create. Add Input 2, 3, and 4.

c) Click Input 1 and add the action in the Action panel. Proceed to 
configure each control action.
Note: 

 The same entries are created for all devices in the list. Skip this step if 
the control action does not apply.

 For full details about configuring control actions, see Configuring 
Button/Slider Bar Actions, page 90.
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Removing a Monitor / Control Item

To remove a monitor or control item, right-click the header and select Delete.
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Uploading Viewers
The Upload page allows you to upload Viewers and/or back up projects to con-
trollers.

To back up a project and its Viewers to a controller:

1. Browse for the ATEN controller where you wish to save the configured 
Viewers.

 Auto Search: Browses for controllers on the same LAN with the 
Configurator.

 Search by IP address: Use this function to browse for controllers that 
are on different LANs to the Configurator.
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2. Verify the selected controller and viewer and configure the selection if 
required. 

 Controller highlighted black: This is the controller that is found in the 
network and its ID matches the one you specified in this project file. The 
viewers created for the controller are listed below this item.

 Controller highlighted gray: This is the controller that also exists in the 
network, but does not match the controller ID specified in this project 
file.

3. Optionally click on the following to configure password authentication 
settings.

Note: Due to security concerns, the access key of any ATEN controller will 
need to be modified at least once before the controller can be accessed for 
any of its functions. If you have not modified the access key, the upload will 
not be performed. To resolve this issue, log in to the controller’s web 
interface and follow the on-screen prompt to modify the access key.

 Edit Access Key: Click to edit the access key you entered for 
uploading Viewers to the controller and download Viewers from a 
mobile device. 
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 Note: A valid access key should only contain upper-case alphabets, 

lower-case alphabets, and/or numerals. : An access key is 

required to upload Viewers to the controller and download Viewers from 
a mobile device.

 : An access key is not required to upload Viewers to the controller 

and download Viewers from a mobile device.

  : The access key has been changed on the controller’s web 

interface (Dashboard). To change the lock status, click on the icon and 
type the new access key to proceed.

4. Click Upload to Controller.

Note: By default, the project file is uploaded along with your selected 
Viewers. To only upload the selected Viewers, click Also upload project file 
to disable the function.

Viewing Controller Information
Click  to view the controller’s information.
 IP Address: Displays the IP address. 
 MAC Address: Displays the MAC address.

 License: Displays the number of licenses available and in use. 

 Select License: Allows you to load a new license file.

 Reset License: Resets all license(s) in use by mobile devices. This will 
disconnect all mobile device connections to the controller.

 Firmware Version: Displays the firmware version.
 Capacity: Displays the amount of space available for uploading Viewers.

 Viewers: Lists the Viewers currently stored on the controller.

 Remove Viewer: Click the trash can icon to remove the Viewer stored 
on the controller. 

 Project: Lists the project file currently stored in the controller.
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Chapter 3
ATEN Database Generator 
The ATEN Database Generator is a tool for creating and customizing device 
drivers when ATEN Control System does not already contain the drivers for the 
devices you wish to add to the system. 

This chapter provides the following information:

 Accessing the Database Generator

 My Library

 Editing / Adding a New Device

 ATEN Device Library

Accessing the Database Generator
In ATEN Configurator, goto Tools > Database Generator. The following 
window appears with the Add Device to My Library dialog box opened if you are 
accessing the Database Generator for the first time.
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Menu Description

Add New Device Configure a custom hardware device to add to My Library. 

Add Device from 
ATEN Device Library

Add devices from the ATEN Device Library to My Library. 

Add Device from 
Driver File

Add devices from a database file (*.vkd) to My Library. 

Check Box Click Do not show this dialog again to prevent the dialog from 
appearing when the Database Generator is opened. Use the 
Preferences menu option to bring the dialog window back. 

Close Click the Close button to exit the dialog window. 

Add New Device Configure a custom hardware device to add to My Library. 
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My Library
My Library allows you to create custom hardware devices which can be selected 
to configure ports on the controller. My Library lists all the hardware devices 
that you have created, added, and edited using the Database Generator. You 
can create new hardware devices or add existing devices from the ATEN 
Device Library (page 199). These devices can then be selected from My 
Device Library for use. 
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Function Tabs
More functions can be accessed from the function tabs toward the top of the My 
Library window. Refer to the table below for information about each function.

Tab Description
File The File menu provides options to:

 Add New Device: Configure a custom hardware device to 
add to Device Library.
 Add Device from ATEN Device Library: Add devices from 

the ATEN Device Library to My Library.
 Add Device from Driver File: Add devices from a database 

file (*.vkd) to My Library.
 Export My Library: Saves My Library as a database file 

(*.vkd) that can be imported later.
 Export Selected Device: Saves the selected device(s) as a 

database file (*.vkd) that can be imported later. 
 Controller Connection: Searches for a controller to test the 

connection or run the learning mode for the IR port.
 Quit: Exits the program. 
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Edit The Edit menu provides options to:
 Delete: Deletes the selected devices from the database. 
 Duplicate: Makes a copy of the selected device(s) and adds 

them to the library with the extension “-Copy”

 Preferences: Provides options to:

 Set the Language 

 Show Add Device dialog on startup 

 Show IR Learning tips

 Set the IR Learning Timeout - how long to attempt a 
connection to an IR device before IR learning stops.

Library Provides a list of the Libraries that you can open to select 
devices from and edit or add to My Library. The libraries that are 
listed here appear when you select a database using Add 
Device from Driver File.

Help Provides support and software version information. 

Tab Description
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Controls on the My Library Window
You can add new devices by creating a new device, duplicating an existing 
device, selecting a device from the ATEN Library or importing a driver file. Use 
the check boxes to select individual devices or All to select the entire list.

Click to add a new custom device to the database.

Select a device and click this icon to create a duplicate.

Click to add and edit a device from the ATEN Device Library.

Click to add a device from the driver file.

 Select a device and click Edit to change the settings.

 Key in word strings then click Search to find a device.
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 Click All, Serial, IR, DO, Relay or Ethernet to filter the list by type. 

 Click Brand, Category, Model, Type or Version to sort the devices.

 Click Export Selected Device to save the selected devices. 

 Click Delete Selected Devices to remove the selected devices. 
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Editing / Adding a New Device
To edit or add a device to My Library, do the following:

1. From the menu select File > Add New Device, or select a device from My 
Library and click Edit.

2. Under General, use the drop-down menus or type in the Brand Name, 
Category, Model and Version. 
Note: The Category determines what buttons are auto generated when a 
Viewer page is created for the device. 

3. Use the History button to open the Version History editor and make notes 
about the updates being made to the device configuration. You can create 
and use different versions of the same device and track the changes. The 
version history can be viewed and different versions selected from the 
ATEN Configurator, under device Properties. 

4. Check the hardware type and configure the device. ATEN database 
generator supports serial, IR, digital output, relay, and Ethernet devices. 
For more information about configuring each of these device type devices, 
refer to the following sections.

 Serial: See Serial Device, page 182.

 IR: See IR Device, page 186.

 Digital output: See Digital Output Device, page 188.

 Relay: See Relay Device, page 189.

 Ethernet: See Ethernet Device, page 190.
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Serial Device

 Click to add an Action. 

 Click to create a duplicate of the Action.

 Click to delete the selected action. 

 Click to enter a string within () which allows the text to be edited 
from the VK6000 in the Button Action - Commands list (see page 90).

 Click to add a drop menu into a Command string, and then enter the 
number sequence in the brackets []. The Function name must include 
an asterisk (*) for each drop menu in the Command string.The drop-
down menu will appear where the (*) is entered in the Function name. 

Note: To allow reserved characters to be part of the command, type a 
backslash “\” in the command column, followed by the special character.
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 Click to add an Enter into the Command string.

Right-click one or more serial commands to copy and paste them as 
Ethernet commands of all protocols (except HTTP/HTTPS):

 Settings – Use the drop-down menus to set the: Baud Rate, Data Bit, Stop 
Bit, Parity, Flow Control and Mode settings. 

 Listen – Use this function to create a list of device parameters that you 
want the controller to monitor by receiving notifications on setting or 
status changes of the specified parameters. 

Note: To set up queries for the status of a device parameter, go to the 
Function List and click  to add the querying action as a command.

 Advanced
 Delay Interval – Sets a time delay for each command before they 

are sent to the device. 

 Feedback Timeout – Sets the maximum interval that the 
controller allows in between parts of a feedback message. If the 
controller has not received any feedback for longer than the 
specified Feedback Timeout, the controller identifies the last bit of 
the received information as the end of a feedback message.

 Receive Duration – Sets the allowed duration of time for the serial 
device to receive a complete message from the controller.

 Checksum Type – To have the checksum automatically calculated 
and filled in by the controller, select Modbus for this setting.

 Keep Connection Alive – Specify an interval that the controller 
waits before sending the specified command to test if the 
connection to the serial device is up or down.
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 Function List – Use this section to configure the device functions by 
adding actions to the list. 

 String Format – Use the buttons to select HEX or ASCII. To use HEX 
strings with ASCII one, select ASCII and type \x before typing the HEX 
strings. 

Note: HEX strings are also supported under the ASCII format.

 Function – Lists the actions created for a device. A Function name 
must include an asterisk (*) if you are adding a drop menu to the 
Command string. Double-click to edit the function name. 

 Command – Shows the command string created for the action. Double-
click to edit the string.

 Message – The Message column is used to create and store feedback 
and/or queries for the corresponding command. 

 For more information about adding feedback, see Testing 
Commands, page 195.

 For more information about creating queries, see Configuring 
Queries, page 197. 

 Click Send to connect to a controller and test the typed command. 
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 Click to select a controller from the list. Use the Refresh button to 
refresh the list. To browse for controllers in the LAN, click the 
Intelligent Search button or type the IP address of the controller.

 Click OK to proceed to test the command. For details, see Testing 
Commands, page 195.

Text Command Tools
The following formats allow you to enter command strings with text that provide 
special features. These formats work in Serial and Ethernet commands. 

 ()  entering text in () allows the command to be edited in the VK6000. 
Example: (A1 A9) (A8 B6) – this command string will provide two editable 
text boxes from the VK6000 in the Button Action - Commands list which 
allow you to change the command string:

 =  using the equals sign before a text command allows you to type in words 
which will show up in a drop-down menu to describe the command, rather 
than show the text command itself. 
Example: [Power On=0A,Power Off=0B,Standby Mode=0C] – this 
command string will provide a drop-down menu with three choices using 
the text before the equal signs to describe each command – from the 
VK6000 in the Button Action - Commands list:

 Quotation marks (“ ”) allow three symbols (, = @) to be added to a 
command that uses the equal sign as described in the example above. 
Three symbols not allowed within the quotation marks include (“” () []). 
Quotation marks can be used to the left of = in a HEX command; on either 
side of = in an ASCII command; and anywhere in an Ethernet command.
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HEX Example: [“Power=On”=0A,”POWER=Off”=0B]

ASCII Example: [“Power=On”=pwn,”POWER=Off”=pwf]

In the HEX example, “Power=On” allows the equal sign to be inserted 
before =0A. If the quotes are removed, the command Power=On=0A 
would fail as an Invalid String.

IR Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected action. 

 Settings – Use the drop-down menu to set the Repeat setting (number of 
times a signal is sent): 1 Time, 2 Times or 3 Times (Default). 

 Advanced 

 Delay Interval – Sets a time delay for each command before they 
are sent to the IR device. 

 Receive Duration – Sets the allowed duration of time for the IR 
device to receive a complete message from the controller.
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 Function List – Use this section to configure the IR functions by adding 
actions to the list. 

 Click  to add an action. In the pop-up dialog box: 

 Auto Learn: Select this option to add the action through learning,

 Manual Input: Select this option to add the action using Pronto 
hex codes. Double-click the command to enter the Pronto code for 
the device.

Note: To obtain Pronto codes for a control system managed, third-
party device, search Internet forums or the manufacturer’s product 
web pages.

 Quick Mode – Click to run Learning Mode for all IR actions in the 
Function List. When the Quick Mode window opens, click Start, a pop-
up window appears to select a controller. Check a box to select a 
controller and click Select. Click Start a second time to run Quick Mode 
using the Learn instructions below. 

 Function – Lists the actions created for a device. Double-click to edit 
the Function the name. 

 Status – Reports the status (Tested, Failed, Learned) of the Learn and 
Test buttons. 

 Learn – Use to transfer commands from an IR remote to the Control 
Box. Click Learn. The Select Controller window appears. 

 Click to select a controller from the list. Use the Refresh button to 
refresh the list. To browse for controllers in the LAN, click the 
Intelligent Search button or type the IP address of the controller.

 Click Learn a second time to start learning mode. When the IR 
Learn LED flashes green, point the IR remote at the Control Box’s 
front panel IR Receiver and push a button on the remote. Press 
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the button on the remote just as you would when using it with the 
hardware device. If the device responds to a long hold or quick tap 
of the remote’s button then you must press the button in the same 
manor (long hold or quick tap) when it using for Learning mode. 
The Control Box will beep and the Learn LED will light solid (then 
turn off) when IR learning is successful. The LED also turns off if 
Learning mode times out.

 Test – Use to test if commands are sent successfully to the Control Box 
and hardware device. 

 Click Test, a pop-up window appears to select a controller and the 
IR port. Check a box to choose a controller and use the drop-down 
menu to select the IR port and then click Select. 

 Click Test a second time to test if the IR data transmits 
successfully to the Control Box. Check the hardware device to 
confirm that it responded appropriately. 

 The Status column reports the Learn and Test results.

Digital Output Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

 Advanced – Click to use the Delay Interval drop-down menu to set a timed 
delay for each command before it is sent to the device.
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 Function List – Use this section to configure the Digital Output device 
functions by adding actions to the list.

 Function – Lists the actions created for a device. Double-click to edit 
the Function name. 

 Command – Shows the command selected for the action. Click the 
drop-down menu to select an action (Open, Close, Toggle, Pulse).

Relay Device

 Click to add an Action. 

 Click to create a duplicate of the Action

 Click to delete the selected Action. 

 Advanced – Click to use the Delay Interval drop-down menu to set a timed 
delay for each command before it is sent to the device.

 Function List – Use this section to configure the Relay device functions by 
adding actions to the list.

 Function – Lists the actions created for a device. Double-click to edit 
the Function name. 

 Command – Shows the command selected for the action. Click the 
drop-down menu to select an action (Open, Close, Toggle, Pulse).
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Ethernet Device

 Click to add an Action.

 Click to create a duplicate of the Action.

 Click to delete the selected action.

 Click to enter a string within () which allows the text to be edited 
from the VK6000 in the Button Action - Commands list (see page 90).

 Click to add a drop menu into a Command string, then enter the 
number sequence in the brackets []. The Function name must include 
an asterisk (*) for each drop menu in the Command string. 

Note: To allow reserved characters to be part of the command, type a 
backslash “\” in the command column, followed by the special character.

 Click to add an Enter into the Command string.

Right-click one or more Ethernet commands (except HTTP/HTTPS) to 
copy and paste them as serial commands:



Chapter 3. ATEN Database Generator

191

For special command string tools, see Text Command Tools, page 185.

 Settings
 Protocol – Click the drop-down list to select a protocol for the device

 Port – Type the port number for the device.

 Advanced – Click to configure the following settings. The supported 
settings may vary depending on the device protocol and authentication 
type.

Delay Interval Sets a time delay for each command before they are sent to 
the device.

Delay Time after 
Login

Sets a time interval that the controller waits to request for 
login credentials of a device after establishing connection with 
the device.

Receive Duration Sets the allowed duration of time for the Ethernet device to 
receive a complete message from the controller.

Send command 
after successful 
connection

Enter a First and Second Command to send to the device 
after a successful connection has been established. 

Auth Type Sets the authentication type for the device.
Timeout Specifies the maximum time that the device allows for 

receiving each feedback message from the device before 
timing out.

URI path Type the part of the WebSocket URI that follows its
communication port. For example, if the URI is
wss://<host>:31416/Dicentis/API, type /Dicentis/API in this 
field.

Sub-protocol Type the subprotocol for the Ethernet device. This
information shall be available in the device’s reference or user 
manual.

ExHeader Type the required data for handshake header.
Extension Type the required data for the Sec-WebSocket-

Extensions header field.
Login Command Sets the command for logging in to the device.
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 Function List – Use this section to configure the device functions by 
adding actions to the list. 

 String Format – Use the buttons to select HEX or ASCII. (TCP only)

 Function – Lists the actions created for a device. A Function name 
must include an asterisk (*) for each drop menu you add to the 
Command string. Double-click to edit the function name. The drop-
down menu will appear where the (*) is entered in the Function name

 Command – Shows the command string created for the action.

 To edit a command for a Telnet, PJLINK, ONVIF, or TCP compliant 
device, double-click the Command field (green area in the 
interface).

 To edit a command for an HTTP or HTTPS compliant device, click 
the Edit button. The Edit HTTP(S) Command window appears. To 
write commands in JSON format, enable the JSON format 
checkbox.

Parameter Sets the parameters (keys) of the device that are required for 
the controller to connect to the device. For example, the 
device username and password are required when 
connecting to the device, and the valid values are admin and 
123456 respectively. 

Keep Connection 
Alive

Specify an interval during which the controller sends the 
specified command to make sure the it is connected to the 
Ethernet device.

Automatically 
reconnect if no 
return message is 
received 

Check this box if you want to continue reconnection attempts 
when no return message is received from the device.

WSS Select to encrypt the WebSocket connection.
Use Default Click this button to restore to default settings. 
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Note: When JSON format is enabled, the drop menu function 
(using square brackets) will be disabled.

 Feedback – Stores return messages generated by testing the 
command strings. Double-click to manually add or remove stored 
messages. This function is not applicable for ONVIF devices.

 Send – Click this button to test the command for the function. The 
return messages can be saved to Feedback. 
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This screen appears when Send is clicked. Select a controller for the 
device to connect and configure the fields such as device IP address. 

Intelligent Search Click to locate controller without specifying an IP 
address.This option only searches for controllers on the 
same local area network. For controllers across a 
network device, such as a router or switch, you must 
specify the IP address. 

Search by IP address Enter the IP address and click Search to locate a 
controller.

Controller ID Use the check box to select the Controller, fill in the IP 
Address, Username and/or Password and then click 
OK. Next use the instructions below this table. 

Refresh Click this button to refresh the Controller ID list.
IP Address Type the IP address of the device.
Username Type the device’s username.
Password Type the device’s password to grant access right to the 

controller.
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Note: The username and password are not required for UDP and TCP 
devices, and the username is not required for PJLINK devices.

Testing Commands
After selecting a controller for the device and configure the required settings (if 
any) in the select controller window, click OK to proceed to test the typed 
command. The Test Command window appears. 

Receive message for Specifies the maximum allowed time that the device 
receives messages from the selected controller.
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Select which device to send command to by choosing Send to all or Send to 
specific and then click Send Test Command. This window appears.

The test results will appear in the yellow area of the window and the feedback 
messages listed in the Feedback column.

 Add – Click to save a feedback message in the Saved Feedback message 
window.

 Pause / Continue – Click to pause sending/receiving the command/return 
message. 

 Save & Exit – Save the feedback messages to the list and close the 
window.
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Configuring Queries
You can set up queries to actively monitor parameters of a serial or Ethernet 
device and store the obtained value into a variable for reuse in a control system 
project. 

Take the example of querying the cumulative number of hours that a projector 
lamp has been used to be able to estimate the remaining lifespan and plan for 
replacement in advance. 

1. In Database Generator, click Edit to enter the settings page for the 
projector.

2. Add a command by clicking  and double-click the command column to 
type the command of requesting for the cumulative lamp usage (hour). 
Consult the user manual for the device to find out the operation command.

3. Set up a variable to store the queried value.

a) In the Message column, click Edit. The Edit Messages window appears.

b) Click the Script tab and click +Add Script and name the script. 
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c) Write up a script to create a variable that stores the requested value, in 
this case, the cumulative lamp hour.

d) Click Save.
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ATEN Device Library
The ATEN Device Library can be accessed from the project bar and provides 
the complete list of hardware devices available in the database. The You can 
add any device in the ATEN Library to My Library. Once a device is added to 
My Library, the device settings can be edited as needed. 

 Use the check boxes to select devices to add to My Library. Check All to 
select all devices in the list. 

 Key in word strings then click Search to find a device.

 Click All, Serial, DO, IR, Relay or Ethernet to filter the device list by type. 

 Click Brand, Category, Model, Type or Version to sort the devices.

 Click Add to My Library to add the selected devices to My Library. 

 Click Cancel to return to My Library.
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Chapter 4
Remote PC Control
ATEN controllers support remote control of computers via ATEN ControlAssist, 
an application program installed to target computers to grant control privilege to 
controllers via the network. 

This chapter provides the following information:

 Function Highlights

 Minimum System Requirements

 Supported File Types

 Setting Up Remote PC Control

 Supported PC Control Actions

Function Highlights

When a computer is installed with ControlAssist, you can remotely perform the 
following:

 Control PowerPoint slides

 Control media files through Windows Media Player

 Initiate actions on third-party programs using hotkeys that have been 
defined for the programs

 Perform system control such as shutting down the computer, execute 
command prompt, set system volume, and run a program. 
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Minimum System Requirements

 Supported computers

 Only Windows-based computers are supported for remote control.

 Each computer is deemed as an Ethernet device to the ATEN controller, 
and therefore follows the specification that each controller can support 
up to 25 Ethernet devices.

 To use ATEN Viewers on a Windows platform, make sure to install Internet 
Explorer version 11 or later.

Supported File Types

 PowerPoint File Control

 ControlAssist only supports PowerPoint files that contain 200 slides or 
less, and are created using Microsoft Office 2007/2010/2013, or WPS 
Office.

 ControlAssist only supports the following PowerPoint file formats: pps, 
ppt, and pptx.

 Media File Control

 ControlAssist only supports media files created using Windows Media 
Player.

 When a media file is remotely enabled and controlled using an ATEN 
Viewer, the file opens in Windows Media Player and this setting can not 
be changed.

 If you encounter any issues playing a media file, try install a third-party 
video codec.

 ControlAssist only supports control of the following media file formats: 

Category File Formats

Windows Media format asf, wma, wmv, wm

Windows Media Metafiles asx, was, wvx, wmx, wpl

Microsoft Digital Video Recording dvr-ms

Windows Media Download Package wmd

Audio Visual Interleave avi

Moving Pictures Experts Group mpg, mpeg, m1v, mp2, mpa, mpe, m3u
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Setting Up Remote PC Control

Follow the steps below to install the required programs on the target computers, 
configure the associated controller, and customize the Viewer for remote PC 
control.

1. Make sure you have installed Microsoft Visual C++ Redistributable for 
Visual Studio 2015 to the target computer. To download the package, go to 
https://www.microsoft.com/en-us/download/details.aspx?id=48145

2. Install ControlAssist on the computer you wish to control. For detailed 
steps, see Installing ControlAssist on Target Computers, page 203.

3. Add the computer into the control system. For detailed steps, see Adding 
Target Computers to the Control System, page 205.

4. Create a control interface to be used on a licensed mobile device. 

 For detailed steps, see Configuring a Control Interface, page 207.

 For details on licenses, see the user manual for your specific controller.

Musical Instrument Digital Interface mid, midi, rmi

Audio Interchange File Format aif, aifc, aiff

Sun Microsystems and NeXT au, snd

Audio for Windows wav

CD Audio Track cda

Indeo Video Technology ivf

Windows Media Player Skins wmz, wms

QuickTime movie file mov

MP4 audio file m4a

MP4 video file mp4, m4v, mp4v, 3g2, 3pg2, 3gp, 3gpp

Windows audio file aac, adt, adts

Category File Formats

https://www.microsoft.com/en-us/download/details.aspx?id=48145
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Installing ControlAssist on Target Computers
Follow the steps below to install ControlAssist on the computers you wish to 
control. 

1. Download ControlAssist.

a) Visit the ATEN download page:
https://www.aten.com/global/en/products/professional-audiovideo/
control-system/controlassist/

b) Search for “VK6000”. A list of downloads for VK6000 appears.

c) Click ControlAssist_Vx.x.xxx.zip to download.

2. From the downloaded file, double-click ControlAssist_Setup to install the 
program. An installation wizard appears.

3. Follow the on-screen instruction to complete the installation. 

4. When the installation is complete, ControlAssist  runs in the system 
tray.

Note: Keep the ControlAssist program enabled in the system tray to allow 
the controller to establish connection with the computer.

5. To configure ControlAssist, right-click  in the system tray and select 
Settings. This window appears.

http://www.aten.com/global/en/support-and-downloads/downloads/
http://www.aten.com/global/en/support-and-downloads/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/supportcenter/downloads/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
https://www.aten.com/global/en/products/professional-audiovideo/control-system/controlassist/
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Click the Basic Settings, Certification & Private Key, or About ATEN 
ControlAssist to access the following settings/information.

Note: If the text in the ControlAssist window appears oversized, change the 
desktop font size to its default, and then log in the computer again to resolve 
the issue.

Control Default Description

Basic Settings
The settings with which an ATEN controller needs to establish connection with the 
computer and to gain control right.

Username admin The credentials required for an ATEN 
controller to establish connection with the 
computer. 
Note: To change the username and 
password, make sure to log in the computer 
using an Administrator account.

Password password

Port 6277 The port through which ATEN Configurator 
establishes connection with the 
ControlAssist-installed computer.

Session timeout 3600 The maximal time allowed for the controller to 
establish connection with ControlAssist.

Root Folder N/A This field specifies the computer path under 
which files are display in the PowerPoint 
Control and Media templates’ file list. To 
display files at the computer’s partition level, 
type %MY_COMPUTER% in this field.

Upload SSL Certificate and Private Key
Upload an SSL certificate and its private key to secure sessions between the 
computer and the connected controller.

Certificate Default 
certificate

Click Choose a file from... to browse for an 
SSL certificate.

Private key Default 
private key

Click Choose a file from... to browse for a 
private key SSL certificate.

About ATEN ControlAssist

Version N/A Indicates the release version. 

Visit Official Website N/A Click to open the official website for more 
information.
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Adding Target Computers to the Control System
After you have installed ControlAssist on the computers you wish to control, 
follow the steps below to establish connection between the controller and the 
target computers.

1. From ATEN Configurator, locate and open your project file.

2. Click the Device tab, and from the Ethernet device type category, click on a 
blank device or click Add More Devices to add one.

3. Click Library. This window appears.
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4. Use the search box to search for “controlassist” to load the ControlAssist 
database. This screen appears.

5. Click Add to Project. This computer, identified as an Ethernet device 
installed with ControlAssist, appears in the Device Configuration List.

6. Select the newly added device and configure the Properties settings on the 
right of the interface.
Hint: If you have more than one computers installed with ControlAssist, 
change the device name to distinguish these PCs.

For details on Properties settings, see Ethernet Device Properties, 
page 34.
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Configuring a Control Interface
Example 1:

Follow the steps below to create a control interface that allows you to browse 
and play any file from the specified root folder (see page 203) in the target 
computer. You can follow the same logic for creating a media control page.

1. In the Design tab, make sure your home page contains a presentation 
button and the Viewer contains a PowerPoint page. 

2. Configure the button to have it link to the PowerPoint page if pressed in the 
Viewer.

a) Click the presentation button.

b) Select Link and then double-click the PowerPoint page.
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3. Configure the PowerPoint page if you did not use a built-in Viewer 
template. 

a) In the left sidebar, click PowerPoint.

b) In the PowerPoint page, right-click any blank spot and select 
PowerPoint Control Template. A pre-made screen is added.

c) In the Properties column, use the Select Device drop-down menu to 
select the PC that stores the PowerPoint files you want to play.
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Example 2: 

Follow the steps below to create a quick access button for opening and playing 
a specific PowerPoint file. You can follow the same logic to create a button for 
opening and playing a specific media file. 

1. Create an outlook for the interface.

a) In ATEN Configurator, click the Design tab.

b) Click Add Page and rename the page to “presentation”.

c) Customize the interface and add control buttons using the Properties 
settings in the right-hand column. For details, see Configuring the 
Control Interface (Viewer), page 43.

2. Define the action of each button. For example, for the PowerPoint button 
to open and start a slide show when pressed, do the following:

a) In the preview pane, click the PowerPoint button.

b) Select ControlAssist (LAN).

c) Double-click [PowerPoint] Open file and then [PowerPoint] Start 
presentation.

d) Configure the commands and arrange them in the order of execution.
Tip: The asterisk (*) at the end of a Function indicates that it requires 
configuration in the Commands column.

2b

2a

2c 2d
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For details on supported control actions, see Supported PC Control 
Actions, page 210.

3. From the Upload tab, deploy and back up the project to the controller. For 
details, see Uploading Viewers, page 171.

Supported PC Control Actions

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 
the Commands column in the Configurator.

[Media Control] 
Note: The commands in this group apply to Windows Media Player only.

Close Closes the player.

Next Plays next in the playlist.

Open file* Opens and plays the specified file in Windows Media Player.

Open playlist* Opens and plays the specified playlist in Windows Media 
Player.

Pause Pauses the playback.

Play Plays the opened file in Windows Media Player.

Previous Plays previous in the playlist.

Set volume to* Sets the player to a specified volume.

Stop Stops the playback.

Switch to full screen 
mode*

Enables or disables the player to full-screen display.

Switch to mute mode* Enables or disables mute mode.

Switch to repeat mode* Enables or disables repeated play.

Volume* Adjusts the player’s volume up or down.

[PowerPoint Control]

Open file* Opens the specified PowerPoint file.

Start presentation Starts the slide show of the specified PowerPoint file.

End presentation Ends the slide show of the specified PowerPoint file.

Close Closes the opened PowerPoint file.

Go to next slide* Goes to the next slide.

Go to previous slide Goes to the previous slide.
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Note: Adhere to the following guidelines when specifying file paths:

 Include the file name and file extension of the target file.

 Use double backward slashes between folder levels.

 If the file path contains space, put the file path in double quotations. 

Go to slide Goes to a specified slide number.

[System Control]

Open file* Opens a specified file saved in the target computer.

Open URL* Opens a specified URL.

Run program* Runs an application.

Shut down PC Shuts down the computer.

Set volume* Adjusts the computer’s volume.

Execute Command 
Prompt*

Executes the specified command via Command Prompt.

Bring application to top* Keeps the window of the specified program on top of other 
windows that are open on the desktop.

[Hotkey Control]

Create action Executes the associated hotkey(s) on the program that 
opens topmost on the computer desktop. 

For example, if you have “Ctrl + f” defined as the hotkey for 
extending a program to full screen in the program itself, to 
remotely simulate this action, you should have one Create 
action command associated with two Select key commands, 
one defined as “Ctrl”, and the other as “f”:

Select key* Use this command to specify the hotkey as defined in the 
target program. If the hotkey involves pressing two or more 
keys at the same time, you will have two or more Select key 
commands associated to one Create action command. See 
the example in the Create action command above.

Command Function

Note: Commands indicated with an asterisk require configuration after being added to 
the Commands column in the Configurator.
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 The following are examples of valid file paths:
“C:\\ControlAssist\\Presentation.pptx”

“C:\\ControlAssist\\Presentation Demo.pptx”
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Chapter 5
ATEN Control System App 
The ATEN Control System App is a platform that allows you to operate your 
control system using pre-made Viewers on mobile devices with an iOS, Android, 
or Windows platform. 

This chapter provides the following information:

 Supported Operating Systems

 Installing ATEN Control System App

 Demo/Start Screen

 Welcome Page

 Managing Viewers

 Managing LAN Devices

 Log Report

 Preferences

 General Settings

 Advanced Settings

 Room Booking System (Room Usage Notifications)
 AppSwitcher

 Report History

 Information

 Download Viewer
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Supported Operating Systems
Make sure your mobile device uses a supported version of the mobile operating 
system listed below before installing the app.

Installing ATEN Control System App
To install the ATEN Control System App on a mobile device, do the following:

1. From the mobile device, tap the App Store  or Google Play  icon.

2. In the search box, type “aten control”.

3. Tap ATEN Control System, and then download and install the app. 

4. The ATEN Control System icon appears on the mobile device.Tap 

the icon to open the app. 

Note:
 The button sound is enabled by default. To mute button sound, go to 

Settings of the mobile device, find ATEN Control app and disable the 
button sound setting.

 The Control System App does not support use on Samsung mobile 
devices when the Samsung DeX feature is enabled.

Mobile Operating System Supported Version

iOS 13.0 or later

Android 8.0 or later

Windows 10.0 or later
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Demo/Start Screen
When you open the ATEN Control System app for the first time, the demo/start 
screen appears:

Tap Demo to try the ATEN Control System app. Tap Start to find a controller 
and download Viewers (see Welcome Page, page 219). 

Note: The default demo/start screen appears until a Viewer is downloaded to 
the Control System app. After a Viewer is downloaded, the default demo/start 
screen will reappear only if the app is reinstalled, which will also delete all 
Viewers.

The Demo page provides two sample Viewers. Tap either one to view the 
controls of different hardware devices. 
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To return to the demo/start page, tap Quit Demo at the top right corner.

Select a Viewer or press any of the buttons on the Welcome page to demo the 
app. The first Viewer’s name will depend on the OS of the device. 

WinViewer1 / iPad / Android1
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This demo shows a Conference call interface with controls for a Projector, 
Screen and Lighting. Tap any of the device icons to open each of the 
following control pages:

. 



Chapter 5. ATEN Control System App

218

Demo
This demo shows different buttons that can be pressed to control the Projector, 
Lights, Video Wall and Camera. Tap the icons to view control pages for each 
device. Tap the Quit Demo icon to return to the previous page, or press on the 
background until the logout dialog appears.

Control Pages

The images above show control pages for the Projector, Lights, Video Wall 
and Camera in Demo. Tap the Home icon in the lower left corner to return to 
the previous page, or press on the background until the logout dialog appears. 
To return to the demo/start page, tap Quit Demo at the top right corner.
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Welcome Page
The Welcome screen is the home screen of the ATEN Control System app. It 
lists downloaded Viewers and provides administrative options. Tap a Viewer to 
open the controls for a room (see Configuring the Control Interface (Viewer), 
page 43), or use the administrative options listed below.

Control Description

Manage Viewer – Use this page to add, update, and remove 
downloaded Viewers. See page 220 for details.

Manage LAN Device – Use this page to access controller’s 
web console or configure the network settings for controllers 
and the devices that they manage. See page 221 for details.

Log Report – Use this page to lookup logs to troubleshoot 
connectivity issues. See page 225 for details.

Preferences – Use this page to set a password for accessing 
the app or configure the app’s usage settings. See page 226 
for details.

Settings – Use this page to access the system settings page 
of ATEN Touch Panel. This tab is only accessible when the 
Control System app is used on an ATEN Touch Panel.

Information – This page provides information about the 
ATEN Control System’s software version. See page 236 for 
details.
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Managing Viewers
The Manage Viewer page allows you to add, update, and remove 
downloaded Viewers. To download Viewers, tap Add Viewer. 

Control Description

Tap Add Viewer to download Viewers. See page 237 for 
details.

Tap the Information icon to view the MAC Address, IP Address 
and Controller ID of the controller associated with the Viewer.

Update Tap Update to connect to the controller and download an 
updated version of the Viewer. After the update, the 
“Downloaded Successfully” prompt will appear

Remove Tap Remove to delete the Viewer. A dialog box will appear to 
confirm deletion of the Viewer. 
Tap Delete to remove the Viewer, or Cancel to cancel the 
deletion.
Note: Viewers are only deleted on the mobile device, and will still be 
available on the controller. 

Done Tap Done to return to the Welcome page. 
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Managing LAN Devices
The Manage LAN Device page allows you to edit network settings for 

the controllers and LAN devices added in the Configurator software (see Device 
Library, page 41). 

Depending on the LAN device you select, different options are available.Tap on 
a device to open the settings page. Use Edit to change settings, Apply to save 
or OK to exit.

Control Description

Tap to expand controllers to view connected LAN devices.

Tap to open the web GUI.
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Controller

PJLink Projector 

Telnet 
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ONVIF 

TCP 

UDP
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Simulating Viewer Controls with Demo Mode
You can preview Viewers and simulate control actions without connecting to a 
controller using the demo mode. 

1. To simulate controls of a target Viewer, download the Viewer file.
For details, see Download Viewer, page 237.

Note: If you wish to use built-in Viewers, skip this step.

2. Tap the ATEN Control app icon from your mobile device. This screen 
appears.

Note: If you have not downloaded any Viewers to the app, a Demo/Start 
page appears. Tap Demo to use built-in Viewers for the simulation.

3. Tap Settings . The Preferences page appears.

4. Tap Enable demo mode to select the setting and tap Set. Demo mode is 
immediately applied.

5. Tap  to return to the Welcome page.

6. Tap a Viewer to view and try out its control interface.

 To close the Viewer, long tap any space on the mobile device and click 
OK in a pop-up dialog box.

 To disable demo mode, close the Viewer and then go to Settings  
to disable the demo mode setting.



Chapter 5. ATEN Control System App

225

Log Report

The Log Report page lists information and errors which can be used 
to troubleshoot issues. Tap and drag the list to scroll through the logs. 
Tap Back to exit.

Control Description

Tap Save to save the log file.

Tap Report History to view saved logs (see page 235).

Tap Delete to delete the log information.

Tap Back to exit.



Chapter 5. ATEN Control System App

226

Preferences

The Preferences page provides settings for operation preferences of the 
Control System app, access to Room Booking System, and AppSwitcher. 

General Settings
To configure settings related to general usage of the Control System app, tap 

. The General Settings screen appears.
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 Button Sound: Enable this function to play a beep sound whenever a 
control element (button, toggle, slider bar, etc.) is used.

 Seconds to press before the exit dialog appears: This sets the duration 
of idle time. When the app idles for the specified duration, an Exit dialog 
appears to check if the user wants to close the app.

 Screen Mode
Note: This setting only takes effect on Viewer control pages.

 Screen saver: Select this option to start a screen saver when the 
mobile device has idled for the specified duration.

 Screen lock: Select this option for the mobile device to lock the screen 
based on its related setting on the mobile device.

 Always on: Select this option to have the screen on all the time.

 Enable password protection: To restrict access to app settings and 
prevent unwanted configuration, enable password authentication for 
leaving the control pages. 

 Allow keyboard usage when this app is in full screen: Enable this 
option to allow keyboard operation when the app is in full screen.

 Notify me when this app disconnects from the Internet: Select this 
option to notify the user when the app disconnects from the Internet.

 Connect to ATEN Control System devices based on the Manage 
Device IP list: Select this option for the app to identify and connect to 
controllers by IP address instead of the controller ID. This is useful when 
you create projects by duplication, in which case you do not need to re-
configure the controller ID in each project.

 Show alert messages for Ethernet devices managed by the controller 
(only applicable to the iOS version of the app): Enable this setting to 
receive status notifications for the managed Ethernet devices.

 Always open viewers in full screen (only applicable to the Windows 
version of the app): Enable this setting to open Viewers (i.e. control pages, 
for examples see page 216) in full screen.

 Show minimize, maximize, and close buttons (only applicable to the 
Windows version of the app): Enable this setting to show the minimize, 
maximize, and close buttons at the top-right corner of a Viewer (i.e. control 
page, for examples see page 216).
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 Enable demo mode: Select this setting to allow viewing of the control 
pages within the Viewer (with no actual effects) when no controller is 
connected.

 Enable physical buttons on Viewer device (only applicable to VK330): 
To prevent access to physical buttons on the touch panel, disable this 
setting.

 Use fast connection: Enable this setting for the Viewer to connect to its 
designated controller more quickly by skipping the checkup of extension 
boxes to the controller. 

Advanced Settings
To configure advanced functions such as receiving room usage notifications, 
switching between apps, or remote reporting of device faults, access the 
Advanced settings page by tapping the Settings icon  and then toggle to 
Advanced. This screen appears.
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Room Booking System (Room Usage Notifications)
 Access to RBS control

Enable this function to receive room-usage notifications, including check-in, 
check-out, quick booking, and reservation extension on an ATEN Touch 
Panel or Android mobile device.

Note: This function is achieved by receiving action notification through 
ATEN Unizon. Make sure to configure ATEN Unizon as required. For 
configuration details, see ATEN Unizon User Manual.

 Repair Management (Support Center)
Enable this function to allow users to submit service requests from the 
Viewer. When a service request is submitted, a notification is sent to 
Unizon for further processing.

Service options can be freely created in ATEN Unizon. ATEN also provides 
built-in service options that are generally applicable to meeting room 
applications, as shown below:

For full information on setting up service options in Unizon, refer to the 
ATEN Unizon User Manual.
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To submit a service request on your Viewer:

1. Tap . The support center menu appears.

2. Tap on an option. A confirmation message appears.
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3. Tap Confirm. When the request is submitted, the corresponding icon 
grays out. To cancel the request, tap on the grayed out icon again.

 Notification Sound
With RBS control enabled, you can enable this function to play a beep 
sound when receiving room-usage notifications.

AppSwitcher
You can maximize the usage of an ATEN Touch Panel (VK330) using the 
AppSwitcher function, which allows you to install multiple apps (ATEN or third-
party apps) on the Touch Panel and to switch apps should your need changes.

Follow the procedure below to install apps to an ATEN Touch Panel and to add 
them to AppSwitcher to make them available for switching.
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1. Go to Preferences  > Advanced, enable the Access to app switch 
setting.

2. Tap Add App to install an app to the mobile device.

3. Tap  to refresh the list. The installed apps appear on the list.

4. To make an app available for switching, tap the app to add it to 
AppSwitcher. Apps added to AppSwitcher are marked with black  icon. 
Tap again to unselect. You can add multiple apps to AppSwitcher.

5. Tap Set. The AppSwitcher control icon  appears.

6. To uninstall an app, tap Remove App.
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To switch among the installed apps using AppSwitcher: 

1. On your Viewer, find the AppSwitcher control . 

If you can not find the control, go to Preferences  > Advanced page, 

enable the Access to app switch setting, and tap Set. The AppSwitcher 
control should appear.

2. Tap . A list of available apps appear. 

3. Tap from the list to switch the control to the selected app. 
For example:
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Note: If the app you wish to use is not in the list, tap Go to Preferences, 
and then make sure the app is installed and added to AppSwitcher. For 
detailed instructions, see AppSwitcher, page 231.

4. To return to the previous control page, tap Back to main control.
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Report History

When you tap Report History, you can view and export logs. Saved 
log files are listed by date in the left column. Tap a log file to view it in 
the window to the right. Tap and drag the list to scroll through the 
logs. Tap Back to exit.

 Tap Export to send the log as an e-mail attachment.
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Information
The Information page displays the ATEN Control System’s version.
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Download Viewer

The Download Viewer page allows you to search for controllers and 
download Viewers. This page is accessed from Welcome ® Manage 
Viewer ® Add Viewer.

Control Description

Search by IP 
Address

Tap to enter a controller’s IP address, then tap the Search 
icon to find it. When controllers are found on the network, 
they are listed in the Add Viewer box.
A Search History drop-down menu will appear for 
previously searched IP addresses. 

Auto Search Auto Search allows you to search for controllers without 
specifying an IP address. The controller must be powered 
on and connected to the same local network. 

Add Viewer This panel lists the controllers that have been found on the 
network. Each controller lists Viewers that can be 
downloaded to the mobile device. To upload Viewers to a 
controller, see Uploading Viewers, page 171.

Back Icon Back returns you to the Welcome page.

Download After you select the Viewers you want to download, click 
Download to start the process.
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Downloading Viewers
When controllers are found, they appear in the Add Viewer 
panel. Check the boxes of the Viewers you would like to 
download, then tap Download. 

Control Description

Add Viewer The main window lists the controllers that have been found 
on the network. Under each controller is a list of Viewers with 
a check box. 
Use the check boxes to select the Viewers you want to 
download, then click Download. If the Lock icon appears, 
you will be prompted to enter the access key. 
After Viewers download, the “Downloaded Successfully” 
prompt appears. Tap Done to return to the Welcome page 
where the Viewers will be listed. 
Note: After you download a Viewers to the mobile device, the default 
Welcome screen no longer appears. 

Access Key When the a Viewers requires an access key a window 
appears prompting you to enter the key. Enter the correct 
access key and then click OK to download the Viewers from 
the controller. To set the access key, see Uploading Viewers, 
page 171. 
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Tap the Information icon to view the IP Address, MAC 
Address and License information of the controller. The 
license information provides the total number of licenses 
available and the number in use. 

Control Description
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Chapter 6
DebugAssist
ATEN DebugAssist is an application for identifying and diagnosing issues in 
ATEN Control Systems. It captures and logs communications between ATEN 
controllers and managed equipment, and provides tools for testing commands 
and locating key information to efficiently pinpoint issues. This chapter covers 
the following topics:

 Installing DebugAssist

 Interface Overview

 Controller Connection

 Filtering Logs

 Searching Logs with Predefined Conditions

 Issuing Commands to Devices

 Simulating Device Feedback

 Changing Variable Values

 Triggering a Timer

 Rebooting Controllers or Expansion Boxes

 Testing Controls on Viewer Pages

 Reading Log Details

 Log Backups
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Installing DebugAssist

Windows-based Systems
1. Visit the ATEN DebugAssist product page.

2. From the Support and Downloads tab, scroll down to the Software & 
Drivers section, and download the DebugAssist installer for Windows.

3. Double-click the downloaded file. This screen appears.

4. Run the DebugAssist Setup (.exe) file and follow the on-screen 
instructions to install. 

5. When the install is complete, the DebugAssist shortcut appears on your 
desktop.
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macOS-based Systems
1. Visit the ATEN DebugAssist product page.

2. From the Support and Downloads tab, scroll down to the Software & 
Drivers section, and download the DebugAssist installer for macOS.

3. Double-click the downloaded file. This screen appears.

4. Double-click the DebugAssist.dmg file. This mounts a virtual disk, which 
often appears on your desktop or in the Finder sidebar.

5. In the pop-up window, drag-and-drop the DebugAssist.app file to the 
Applications folder to install. Wait for the copy to finish.

6. When the copy is complete, right-click the mounted disk image on your 
desktop or Finder and select Eject.

7. You can now safely delete the original DebugAssis.dmg file from your 
Downloads folder.
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Interface Overview

Main Screen
After connecting to a controller, the main screen appears. Refer to the table 
below for an overview of this screen.

No. Control Description

1 resource lists Lists the controller’s managed equipment, created 
functions including Monitors, Variables, Macros, Timers, 
and Schedules, and the Viewer pages uploaded to the 
controller. For more information about resource lists, see 
Resource Lists, page 249.

2 disconnect / 
resume connection

Disconnect from or resume the connection with the 
controller.

1

4

2

3 5

6 7
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3 function menu Contains basic functions such as file management (Save 
or New), preference settings, and the application version. 
For full information, see Function Menus, page 247.

4 project name Indicates the project file used by the controller.

5 logs Shows the communication between the controller and the 
managed devices.

6 log controls Use these buttons to control log loading, such as starting 
or pausing log loading, clearing logs, auto-scrolling to the 
newest entry. For full information, see Log Controls, 
page 250.

7 system information Shows the controller’s system information, including CPU 
usage, RAM usage, IP address, and the current and total 
entries loaded to DebugAssist.

No. Control Description
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Adjusting the DebugAssist Window
You can adjust the DebugAssist window with the following methods:

 Adjust the column width
Position the pointer between the columns until the resize icon appears, and 
then click and drag to adjust the column width.

 Re-assign the resource lists panel
Click and drag the Project Name row to reposition the resource lists panel.
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You can position it to the left, right, or bottom of the DebugAssist window, or 
detach it to get an expanded view of the logs, as illustrated.
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Function Menus
The function menu on the main screen provides access to opening a new 
connection, saving the currently displayed logs, and configuring display 
preferences. Refer to the sections below for more information.

 File
 New: Starts a connection to another controller. For full information, see 

Connecting to Another Controller, page 255.
 Save as: Saves the currently loaded logs.

Note: DebugAssist needs to be disconnected from the controller before 
the logs can be saved.

 Edit
 Preferences: Contains the following settings.
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 Executable path of Control System App: Specifies the executable 
path of the Control System App. To change the path, click Select and 
browse for the app.

 Limit the size of saved files to (MB): Specifies the size limit of 
loaded logs. The default is set to 1000 MB. 
Note: When loaded logs exceed the size limit, DebugAssist 
immediately disconnects from the controller and stops loading. In 
this case, click Resume Connection and follow the on-screen 
instructions to reconnect with or without saving loaded logs.

To revert these settings to default, click Reset.

 View
 Set toolbar to top

By default, the toolbar is set to the bottom. Enable this option to put it to 
the top, as illustrated.

 Help
 About DebugAssist: Indicates the DebugAssist version.
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Resource Lists
When DebugAssist connects to a controller, it reflects the following information 
in condensed lists (as illustrated below):

 managed devices

 functions including Monitors, Variables, Marcos, Timers, and Schedules

 uploaded Viewer pages 

In the resource lists, the following controls are available. Refer to the table 
below for an overview of their functions.

Controls Function Highlights
Click to open the list in a separate window.

Click to display the information.

Indicates device connection status.

 Green: the device is online.

 Black: the device is offline.

Indicates that the logs of the corresponding item is shown. To 
hide the logs, click on the icon.

Indicates that the logs of the corresponding item are hidden. To 
show logs, click on the icon.

Click to execute a Marco, Timer, or schedule, or to open a Viewer 
pages. This button only appears when the resource is moused 
over.

Click to enable or disable the function. The toggle button 
disappears when the device is offline.
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Log Controls
The log controls on the main screen allow you to load logs and control how 
loaded logs are displayed. Refer to the table below for descriptions of each 
function.

No. Control Description
1 Play / Pause Click to start or pause loading of logs.

2 Clear Click to clear loaded logs.

3 Keep to the last 
line

When enabled, the view is always kept to the last 
loaded entry.

4 Stop auto-scroll 
at matching entry

This feature allows you to add and save multiple 
searches each with specified resource type 
(category), name/port, and/or message. When 
enabled, DebugAssist automatically searches logs 
based on the added criteria and stops at any 
matching entry. For more information on setting up 
the function, see Searching Logs with Predefined 
Conditions, page 258.

5 Go to previous 
matching entry

With Stop auto-scroll at matching entry enabled, 
click this button to go to a previous matching entry.

6 Go to next 
matching entry

With Stop auto-scroll at matching entry enabled, 
click to go to the next matching entry.

1 2 3 4 5 76
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7 System 
Information

Indicates the following information:
 Controller’s IP address
 CPU usage
 RAM usage
 Total number of entries and currently focused 

entry
Hint: You can search for a specific entry by its 
number. Click on the first entry number, type in 
the blue block, and press Enter.

No. Control Description
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Controller Connection

Connecting to a Controller
1. Launch ATEN DebugAssist. The DebugAssist window appears.
 Windows

From the desktop, locate the DebugAssist icon from the desktop and 
double-click it. The main screen appear

 macOS
Locate the app in your Applications folder or via Launchpad to launch it.

2. Search for the target ATEN controller using one of the following methods.
 By scanning a specified network interface: From the indicated drop-

down lists, select Scan and the network interface.

 By specifying the IP address: From the drop-down list, select IP 
Address and type in the IP address in the indicate box.
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3. Click Search. All found controllers are shown.

4. Click to select a controller and click Connect. This dialog box appears.
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5. Type in the controller’s access key and click Continue. The main screen 
appears and DebugAssist connects to the controller and auto-scrolls to the 
newest log.
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Connecting to Another Controller
Depending on your computer’s capability and network bandwidth, you can 
connect DebugAssist to more than one controllers at the same time, each on a 
separate window. To connect to another controller:

1. Go to File > New. This screen appears.

2. Search and connect to a controller. For full details, see Connecting to a 
Controller, page 252.
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Disconnecting / Resuming Connection
You can disconnect DebugAssist from the controller by clicking the Disconnect 
button on the main screen. Note that when you resume connection, all loaded 
logs will be cleared.
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Filtering Logs
Use the search box  and/or the show  / hide  buttons to filter 
logs and narrow the search scope, helping you quickly locate key entries.

 Search Box : Type in the search box and press Enter. 
DebugAssist immediately checks the content of all four columns and only 
keeps entries that contain matching content. To clear the typed string, click 

the cross in the search box .

Note: The search is case-sensitive.

 Show  / Hide : From the resource lists, click on the show  / hide 

 buttons to further filter the logs.

To filter logs, for example, to search for AirconCRC monitor event:

1. In the search box, type “Monitor”. The logs are immediately filtered to only 
display entries that contain the “Monitor” string.

2. In the Monitors list, click on the show  / hide  buttons to only keep 
AirconCRC. The loaded logs are further filtered to only display 
communications of the AirconCRC monitor.
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Searching Logs with Predefined Conditions
You can have DebugAssist perform multiple searches, each with different 
category, name/port, and message, concurrently and automatically by 
predefining search criteria.

Understanding Predefined Search
DebugAssist automatically executes search when one or more searches are 
added to its search condition settings. For example:

To view matching entries, use the  buttons from the toolbar to navigate 
between them.
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You can have DebugAssist automatically stops at a matching entry by 
enabling the Stop auto-scroll at matching entry icon , as illustrated.

Note: When a matching entry is found, the  button will be automatically 
disabled.
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Enabling/Configuring Predefined Search
To enable or configure predefined search, follow the steps below to set up one 
or more search conditions.

1. In the pop-up menu, click . The Condition Settings screen appears.

2. In the Condition Settings screen, add one or more searches.

a) Click .

b) In the pop-up entry, configure the category, name/port, and/or message. 
Optionally enable or disable the conditions using the toggle.

c) Repeat steps (a) and (b) to add more searches.
DebugAssist automatically saves the search conditions and execute the 
search.

Auto-stops at Matching Entries
With search conditions configured, you can have DebugAssist automatically 
stops at a matching entry by enabling the stop auto-scroll function. Use any of 
the following methods to do so:

 Click  from the main screen toolbar.

 Click the arrow next to , and then toggle open the Stop auto-scroll at 
matching entry function.
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Issuing Commands to Devices
You can have a controller send commands to managed equipment via 
DebugAssist to check whether the receiving device is responsive and whether 
the communication is function properly. 

To issue a command to a controller:

1. From the Resource List, click  from the Devices list. The Device Details 
window appears.

2. Select a category from the top row, find your target port, and then enter and 
send the command.
For example:
To issue a port switching command through VK2200’s serial port 4 to a 
VM0808H, locate this entry, select an appropriate data type (ASCII or 
HEX), and then type the command in the command field and click Send. 
The action takes effect shortly.

Note: The arrow indicates the direction of command transmission.
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Simulating Device Feedback
You can simulate and send device feedback to its controller to test the function.

To simulate device feedback:

1. From the Resource List, click  from the Devices list. The Device Details 
window appears.

2. Select a category from the top row, find your target port, and then enter and 
send the command. 
For example:
To test communication between a sensor and an expansion box, simulate 
10 seconds of detected motion by applying the value 10 to an I/O sensor in 
closed state (as illustrated) to see if the defined output takes action as 
defined.



Chapter 6. DebugAssist

263

Changing Variable Values
You can change variable values from DebugAssist to check if the device is 
responsive and whether the communication is alive. For more information on 
Variable and its applications, see Variables, page 148.

To apply a new value to a variable:

1. From the main screen Variable list, click . The Variable Details window 
appears.

2. In the Variable Details window, find the target variable and enter a new 
value and click Set. The value should be applied immediately.
For example:
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Triggering a Timer

You can trigger a Timer event to test whether a Timer event functions as 
expected, and make adjustments when needed. For more information on Timer 
and its applications, see Timers, page 157.

To trigger a Timer:

1. From the main screen, open the Timers list.

2. Mouse over the Timer you wish to trigger. A green arrow appears.

3. Click  to initiate the Timer.
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Rebooting Controllers or Expansion Boxes

To reboot a controller or expansion box from DebugAssist:

1. From the main screen, open the Devices list. 

2. Click  of the target controller or expansion box. This dialog box appears.

3. Click Reboot Controller or Reboot Expansion Box, and then follow the 
on-screen instructions to start the reboot. 
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Testing Controls on Viewer Pages
To test controls on a Viewer page from DebugAssist:

1. From the main screen, expand the Viewers list.

2. Locate the target Viewer page.



Chapter 6. DebugAssist

267

3. Click  and enter the access key in the pop-up window. The control page 
opens. 
Example 1:

Example 2:

4. Click on the buttons to test the functions. The applied action takes effect 
immediately.
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Reading Log Details
Some log messages may be too long and condensed. Click  to view the full 
message.

For example: Click the entry of log and click .

The message appears in a separate window.
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Log Backups
Loaded logs can be saved for future reference or shared with others for further 
diagnosis. A backed up DebugAssist file (read-only mode) is indicated with an 
orange line just above the log entries, as shown below.

A backed-up DebugAssist file supports the following functions:

 Search functions (for resource lists and logs)

  Show/  hide functions (for resource lists)

Note: A backed up file is read-only and does not support real-time log loading 
or features involving real-time communications with controllers or managed 
equipment.
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To back up loaded logs:

1. From the main screen, click .

2. Go to File > Save as. The Save As window appears.

3. Select a location and click Save.

To open a saved log file:

Double-click a previously saved file. The file opens in DebugAssist. For 
example:



271

Appendix

Technical Support

International
 For online technical support – including troubleshooting, documentation, 

and software updates: http://eservice.aten.com
 For telephone support, see Telephone Support, page ii

North America

When you contact us, please have the following information ready beforehand:

 Product model number, serial number, and date of purchase.

 Your computer configuration, including operating system, revision level, 
expansion cards, and software.

 Any error messages displayed at the time the error occurred.

 The sequence of operations that led up to the error.

 Any other information you feel may be of help.

Email Support support@aten-usa.com

Online 
Technical 
Support

Troubleshooting
Documentation
Software Updates

https://eservice.aten.com

Telephone Support 1-888-999-ATEN ext 4988
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Control System Project Specifications

Project Elements Maximum Number
Managed IP devices VK0100 / VK0200 8

VK1100A / VK2100A 25

VK1200 / VK2200 64

Rooms 16

Viewers 32

Macros 1024

Variables 1024

monitoring event
VK0100 / VK0200 10

VK1100A / VK2100A 20

VK1200 / VK2200 40

scheduling event VK1100A / VK2100A
60VK1200 / VK2200

Viewer pages 160 per Viewer

control objects 320 per page

commands 128 per button
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Datapoint Types (DPTs)

ATEN Control System supports the following KNX Datapoint Types (DPT): 

DPT ID DPT Format DPT Name

1.001 B1 DPT_Switch

1.002 B1 DPT_Bool

1.003 B1 DPT_Enable

1.004 B1 DPT_Ramp

1.005 B1 DPT_Alarm

1.006 B1 DPT_BinaryValue

1.007 B1 DPT_Step

1.008 B1 DPT_UpDown

1.009 B1 DPT_OpenClose

1.010 B1 DPT_Start

1.011 B1 DPT_State

1.012 B1 DPT_Invert

1.013 B1 DPT_DimSendStyle

1.014 B1 DPT_InputSource

1.015 B1 DPT_Reset

1.016 B1 DPT_Ack

1.017 B1 DPT_Trigger

1.018 B1 DPT_Occupancy

1.019 B1 DPT_Window_Door

1.021 B1 DPT_LogicalFunction

1.022 B1 DPT_Scene_AB

1.023 B1 DPT_ShutterBlinds_Mode

1.100 B1 DPT_Heat/Cool

2.001 B2 DPT_Switch_Control

2.002 B2 DPT_Bool_Control

2.003 B2 DPT_Enable_Control

2.004 B2 DPT_Ramp_Control
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2.005 B2 DPT_Alarm_Control

2.006 B2 DPT_BinaryValue_Control

2.007 B2 DPT_Step_Control

2.008 B2 DPT_Direction1_Control

2.009 B2 DPT_Direction2_Control

2.010 B2 DPT_Start_Control

2.011 B2 DPT_State_Control

2.012 B2 DPT_Invert_Control

3.007 B1U3 DPT_Control_Dimming

3.008 B1U3 DPT_Control_Blinds

4.001 A8 DPT_ASCII

4.002 A8 DPT_Char_8859_1

5.001 U8 DPT_Scaling

5.003 U8 DPT_Angle

5.004 U8 DPT_Percent_U8

5.005 U8 DPT_DecimalFactor

5.006 U8 DPT_Tariff

5.010 U8 DPT_Value_1_Ucount

6.001 V8 DPT_Percent_V8

6.010 V8 DPT_Value_1_Count

6.020 B5N3 DPT_Status_Mode3

7.013 U16 DPT_Brightness

8.011 V16 DPT_Rotation_Angle

9.001 F16 DPT_Value_Temp

18.001 B1R1U6 DPT_SceneControl

20.100 N8 DPT_FuelType

20.101 N8 DPT_BurnerType

20.102 N8 DPT_HVACMode

20.103 N8 DPT_DHWMode

20.104 N8 DPT_LoadPriority

DPT ID DPT Format DPT Name
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20.105 N8 DPT_HVACContrMode

20.106 N8 DPT_HVACEmergMode

20.107 N8 DPT_ChangeoverMode

20.108 N8 DPT_ValveMode

20.109 N8 DPT_DamperMode

20.110 N8 DPT_HeaterMode

20.111 N8 DPT_FanMode

20.112 N8 DPT_MasterSlaveMode

20.113 N8 DPT_StatusRoomSetp

23.001 N2 DPT_OnOff_Action

23.002 N2 DPT_Alarm_Reaction

23.003 N2 DPT_UpDown_Action

23.102 N2 DPT_HVAC_PB_Action

DPT ID DPT Format DPT Name
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ATEN Standard Warranty Policy
The warranty policy may vary by product category and region of purchase. For
details, please visit ATEN's official website, select your purchase counties/
regions and then go to the Support Center, or contact your local ATEN sales
representative for further assistance. 

© Copyright 2026 ATEN® International Co., Ltd.
Released: 2026-02-23

ATEN and the ATEN logo are registered trademarks of ATEN International Co., Ltd. All rights reserved. 
All other brand names and trademarks are the registered property of their respective owners.
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